HP Designijet 1620

Printer series
Using your printer




HP Designjet T620 Printer series

Using your printer




Legal notices

© 2009 Hewlett-Packard Development
Company, L.P.

The information contained herein is subject
to change without notice.

The only warranties for HP Products and
services are set forth in the express warranty
statement accompanying such products and
services. Nothing herein should be
construed as constituting an additional
warranty. HP shall not be liable for technical
or editorial errors or omissions contained
herein.

CERTIFIED

USB 2.0 high-speed certified.

Trademarks

Adobe®, Acrobat® and Adobe Photoshop®
are trademarks of Adobe Systems
Incorporated.

Corel® is a trademark or registered
trademark of Corel Corporation or Corel
Corporation Limited.

ENERGY STAR and the ENERGY STAR
mark are registered U.S. trademarks.

Microsoft® and Windows® are U.S.
registered trademarks of Microsoft
Corporation.



Table of contents

1 Introduction

S T= 1 1= AV o1 C=Tor= U i) SRR 2
o LS =T LU o T ) PO SPR PRSP 2
USING ThiS QUIAE ..o e e e e et e e e e e e e e e e e e es s ba b e e b eeeeeeaeeeeaessannsanrenraees 2
The printer's Main fEALUIES ... ..o et e e e e e e e e e e e 4
The printer's Main COMPONENTS .......cciiiiiiiiii e r e s e e e s e e e e e eeeeeearaenrn e e e eeaaeaeeees 4
B I =T 1o =T = PSSP 6
] YT 1= RO SPPRSPPRRPR 8
The printer's internal Prints ... et e et e e e e e e e e 8

2 Installing the software

Choose which connection Method t0 USE .........eeiiiiiiiiii e 10
Connect directly to a computer (WINAOWS) .......uuuiiiiiiieiiic e e e e e e nrraae e e e aa e 10
Connect to @ NEWOIK (WINAOWS) .....ciiiiiiiiiiie ettt e e e e 11
Uninstall the printer software (WINAOWS) .........uuiiiiiiiiiii e e e e e e e e enenes 12
Connect directly to a computer (Mac OS) .......coooiiiiiiiiii e 12
Connect to @ NEWOrK (MAC OS) ......uiiiiiiiiiiie e e e e e e e e e e s nees 13
Uninstall the printer software (Mac OS) ........coiiiiiiiiiii et e e e 13

3 Setting up the printer

) (oo U Tox [0} o PN 16
Turn alerts ON AN Off ...ttt ettt e e e et e e e e e e e e e e e eeeeeaa e e aeeaaas 16
Set WIiNdows driver PrefEreNCES .........ooiiiiiiiiiie ittt e e e rnb e e 16

4 Personalizing the printer

Turn the printer 0N and Off ... et e e et eee e n 18
Change the language of the front-panel display ............ccccoveiiiiiii i 19
Access the HP Printer ULIITY .......ooo i e eee e e 19
Access the Embedded WEeb Server ... 19
Change the language of the HP Printer ULility ..........cooo i 20
Change the language of the Embedded Web Server ... 20
Change the sleep MOode SEHNG ......oo.veiiiiie e 20
Turn the buzzer 0N and Off ......o it e s eee e e eneee 20
Change the front-panel display CONtrast ... 21
Change the units of MEASUIEMENT ..........ooiiiiiiie e e e e e 21
Configure NEIWOrK SEHINGS .....ooiuiiiiiee e e e 21
Change the graphic 1anguage SELHNG ........ccoviiiiiiiiie e 21

ENWW iii



5 Paper handling

LCT=T =T = =T LV o S 24
Load a roll onto the 24-iNCh SPINAIE .........uviviiiiiiiiiii e e e 24
Load a roll into the 24-INCh PINTET .....ooiii e e e e e e e e e e e e e anan 28
L8]] [o =T 1= T o] | PSR 36
Load @ SINGIE SNEET ... ..o et 37
Unload @ SiNGIE SNEEL ......ccci e e e e e e e aaaaa e e 40
View information about the PAPET ......... ..o e 40
=T LY a0 0] 11 PSPPI 41
Print 0N 10AdEA PAPET ...t e e e e e e e e e e e e et aaeeaaaaeaaeeaaeraeeara—a——_ 41
=TT =] o =1 oY U PUPRPRR 42
Change the drying tMe ..o ettt e e e e e e e e e e e e e e e e e e eaeaaeeeeeeeanan 42
Turn the automatic cutter on and Off ... e a e 42
Feed and CUL Tt PAPET ........eii et e e e e et e e ee e e e e e e e e eeeaeeeabeeeeeerenanean 42

6 Printing

SeleCt Print QUATILY ... et e e e e e e e e e e e e e e e aaaan 46
Lo (=T od o T o1 A = PR 46
Select MArging OPONS ...t e e e e e e e e e e e e e e e eeeaaeaeeaeeaanan 47
Print With SNOMCULS .......eei e e 47
RESCAIE @ PIINE .ot e e et e e e e e e e e e e e e e e et —t e e e e e aaaaaaeaeeeeeerraaa—a 48
Change the treatment of overlapping INES ...........ooi i 49
PN @ Arafl ..o 49
High-quality PrINEING ....eeeeee e e s e s et e e e e e e e e e e s 50
Print in gray SNAAES ... ...t e e e e e e e e e e e e e ae e e an 51
Reprint 1ast Printed JOD ... et e e e e e e e e e e e e 51
Use Paper €CONOMICAILY .......eeiiiiiiiieii ettt e e e sttt e e e et e e e e e e nbe e e e e e nnbeeeeeeeennreeas 52
LU LTI o] Q= TeTo] g o] o 4111 1 PR 52

7 Color management

T} 1o [F T3 o] o PR 54
HOW COIOIS @re repreSENIEA ......... i e e e e e e e e e e et e e e e e e e eeeeereeeeseeanean 54
A summary of the color managemMeNt PrOCESS ........coiiiiiiii i 54
L0701 [o] gl o= 1] x= 11 [o] KSR PP 54
Color management from Printer AFIVETS .........ooiiiiii i e 55
Color management from the front PANEI ..........cccuiiiiiiiiiii e 58

8 Practical printing examples

Print a draft for revision with the correct scale ..............cccccuuiiiiiiiiiiiiiee, 60
L T 1 A= T o] 0] = PSR 62
Print @ PresSentation .......... i aaaeaaaaaaeaeeeraaa——— 70
Print and scale from MiICroSoft OffiCE .........ciiiiiiiiiieecc e aaaaa 76

iv ENWW



9 Handling ink cartridges and printheads

ADOUL the INK CAMIIAGES ....eeiiiiiieie et e et e e e e s aaa e e e e aabeeeeeeaae 84
Check the ink cartridges STAtUS ........ueeiiiiiiiie e e e e e e 84
REMOVE @n iNK CAMIIAQE ....ooiiiiiiiei et e e e e et e e e s sbe e e e e aaes 85
[aTS Y=Y o = T T Qo= T 1 o o = PR 86
AbOUL the PrINthEAAS ... ettt e e e e e e e e e e e e aeeeeee s 87
Check the printhead STAUS .........oiiiiii e e e e a e e e e e 88
RemMOVE @ PrINtNEAA ... ettt et e e e e e e e e e e eeeeeeeeaaae e e s e e aennnnns 88
L TST=Y o = T T =T T SRR 91

10 Maintaining the printer

(O o1t o 4T Y (=T ] €= | L0 [ SRRRRRE 96
Clean the exterior of the PrINTEr ........ . e a e 96
REPIACE The CUHIET ... . e e e e e e s e e e e e et e e e eereeeeeeeeeseeaannnnns 96
Maintain the iNK Cartridges ........c.uueiiii e e 100
MOVE OF StOrE the PIINLET .. e e e e e e e aaaeeeeeseeannneennnens 100
Update the fITMWArE ... ettt e e e e e e e e e e aeaaeeees 101
Update the SOfIWAIE ........oooii e e et e e e e e e s neeeeas 102
Printer maintenance Kits ........ ... e e e 102

11 Accessories

How to order supplies and @CCESSONES ......ccociiiiiiiiiie e s s e e e e e e e e e e e e e e e e e e e eeeeaeeees 106
INtroduction 10 the ACCESSOMES ......uuuiiiii i e e e e e e e e e e e e e e e eeaeeaeeaeeeeees 110

12 Troubleshooting paper issues

The paper cannot be loaded SUCCESSTUILY .......c.ooiiiiiiiiiii e 112
The paper type is Notin the AriVEr ... e 114
The paper has JAMMEd ........o..euiiiii e e et e e e s s bbbt e e e s e naeeeeeean 115
The printer displays out of paper when paper is available ..............cccccccoiiii . 118
Prints do not fall neatly into the basket ..............ooi e 118
The sheet stays in the printer when the print has been completed ... 118
The paper is cut when the print has been completed ..., 118
The cutter does NOt CUL WEIL ... e et e e e 118
The roll is 100Se 0N the SPINAIE ......eeiiiii e ee s 118
A strip stays on the output tray and generates jams ... 118
Recalibrate the paper adVanCe ..........oouiiiiiiii e 119

13 Troubleshooting print-quality issues

ENWW

1o a1t T BE=To AV o PR 122
Print quality troublesShOoting WIZard ...........coooiiiiiiiii e e e 122
Horizontal lines across the image (banding) .........cooooiiiie e 123
Lines are too thick, t00 thin Or MISSING ........c.oiiiiiiii e 124
Lines appear stepped OF JAGGEA ....cooi i e e 124
Lines print double or in the Wrong COIOIS ........cooiiii e 125
Lines are diSCONTINUOUS .........ooiiiiiiiiiie ettt e e et e e e ettt e e e e s nnbe e e e e e nnbeeee e enneeas 125



[T a LTSRN o] [T =T N 126

Line 1engths are INACCUIALE .........ooiiiiiiiie et e e e 127
The whole image iS BIUMY OF Grainy ......ccccccuieiiiiieee e rr e e eaaaaaens 127
The paperis NOt flat ..o ettt e et e e e e e e e ene e neeeeeeeas 128
The print is scuffed Or SCratChed ............ouuiiiiiiiiiii e 128
0] N A E= T T g TR a1 = = PSR 129
Black ink comes off when you touch the print ... 129
Edges of objects are stepped or NOt SNAIP .....ooooii i 130
Edges of objects are darker than expected ............cccueuiiiiiiiiiiiieeee e 130
Horizontal lines at the end of a cut sheet print ... ... 130
Vertical lines of different COIOTS ..........uuiiiiii e 130
White SpPots ON the PriNt ... e e e e e e e e e e s e e e 131
1070] (o] =T (-0 0 F= o o1 U ] = | (= YRR 131
1070] (o] £ 1= T (=0 £=To [T o OO PP PO PP PP P PPPPPPPPN 132
The image is incomplete (clipped at the bottom) ..o 132
The iIMage iS ClIPPEA .. .ottt et et e e e e e e e e e e e e e e ae e e e ne e eeeeeeeeeas 132
Some objects are missing from the printed IMage ... 133
A PDF file is clipped or objects are miSSIiNg ........coooiiiiiiiiiii e 133
The Image DIiagnostiCs Print ..ot e 133
If you still have @ ProbIem ...t e e e e e e e e e e e e e nnneneees 136

14 Troubleshooting ink cartridge and printhead issues

Cannotinsert an iNK Carridge .. ...oooiiiiiii et e e e e e e e e s 138
INK cartridge Status MESSAGES ... ..ueiiiiiiiiiii et e e e e e e e e e e ee e e e 138
Cannot inSert @ PriNthEAMA ........ oo e e e e e e e s 138
The front-panel display recommends reseating or replacing a printhead ..............ccccoccceinis 139
Clean the PriNthEAAS ...........oooi it e e e e e e e e e 139
Clean the printhead drop deteCtOr ..........oiiiiii e 139
Align the PriNthEAAS ... ettt e e e e e e e e e e e e e nenes 142
Printhead Status MESSAGES .....coo i e e e e e et e e e e e 144

15 Troubleshooting general printer issues

The printer dOES NOL PIINT ....coo ettt e e et e e e e s satbeeeaeeeans 146
The Printer SEEMS SIOW ... oot re e e e e e e e e e e e e e e st et e eaaeaeeeeaaas 146
Communication failures between computer and printer ..............eoviiiii 146
Cannot access the HP Printer ULIlITY .........ooooiiiiiiiie s 147
Cannot access the Embedded WED SErVEr ..o 147
Automatic file SYSIEM ChECK ........eeiiiiii e e e s e e e e neeeas 148
An AutoCAD 2000 memory alloCation ©ITOT ..........ccuuiiiiiiiiiieeie e 148
No output when printing from Microsoft Visio 2003 ...........cccoeoeiiiiiie e 148
Unavailable driver features when printing from QuarkXpress ........cccocoveveiiieei e 149
101 (Y =1 [T o £ PP PRUPPTPRT 149

16 Front-panel error messages

Vi ENWW



17 HP Customer Care

INEFOAUCTION ...ceee et e et e e e e e e e e e e e e e e e e e et et et e eeeeeeeaaaaaaaaeaaaeeeeessesenrneas 154
HP ProfeSSional SEIVICES .........eiiiiiiiiiiiie it e e et e e e e e e e e e nnnbae e e e nnneeas 154
| T3 2= L ST o] o) PSS 155
[ |l o o= o 1) TS U o] o o] o S S 155
(070} o1 = T3 Al | =S 10T o] o Yo o A PR 156

18 Printer specifications

Functional SpeCIfiCatioNS .........ooi oot e e e e e e 158
Physical SPECIfICAtIONS .......ccoiiieee e e e e e e e e e e e e e e e e e e e 159
MeMOrY SPECIFICALIONS ......oiiiiiiiiiie e s e e e e e e 159
POWET SPECITICALIONS .....uviiiiiiiee i s e e e e e e e e e e s s e e e e aeeeeeeeeeeannenneens 159
Ecological SPECIfICAtIONS .......ccoiuiiiiiii i e e e 159
Environmental SPECIfICAtIONS ........oviiiiiii i e e e e 159
ACOUSEIC SPECIFICALIONS ...ttt e et e e et e e e e e e e e e e e e eeeas 160
£ T Tt 161
3 T = 163
ENWW vii



viii ENWW



ENWW

Introduction

e  Safety precautions

e HP Start-Up Kit

° Using this guide

° The printer's main features

° The printer's main components

° The front panel

° Printer software

° The printer's internal prints

c
o
-
(3)
=
©
(o)
—
wd
£




Safety precautions

The following precautions ensure the proper use of the printer and prevent the printer from being
damaged. Follow these precautions at all times.

e Use the power supply voltage specified on the nameplate. Avoid overloading the printer's electrical
outlet with multiple devices.
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e  Ensure the printer is well-grounded. Failure to ground the printer may result in electrical shock, fire
and susceptibility to electromagnetic interference.

e Do not disassemble or repair the printer yourself. Contact your local HP Service Representative
for service, see Contact HP Support on page 156.

e Use only the electrical cord supplied by HP with the printer. Do not damage, cut or repair the power
cord. A damaged power cord has risk of fire and electric shock. Replace a damaged power cord
with an HP-approved power cord.

e Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of
the printer. Doing so may cause fire, electric shock or other serious hazards.

e Turn off the printer and unplug the power cable from the power outlet in any of the following cases:
0 When placing your hands inside the printer
° If there is smoke or an unusual smell coming from the printer
0 If the printer is making an unusual noise not heard during normal operation

° A piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal
parts of the printer

° During an electrical (thunder/lightning) storm

° During a power failure

HP Start-Up Kit

The HP Start-Up Kit is the DVD that comes with your printer; it contains the printer's software and
documentation, including introductory multimedia tutorials to help you to get a good first print.
Using this guide

Using your printer (on DVD) and the Quick Reference Guide (on paper) are organized into the following
chapters. The most complete source of information is Using your printer.

Introduction

This chapter provides a brief introduction to the printer and its documentation for new users.

Use and maintenance
These chapters help you carry out normal printer procedures and include the following topics.

° Installing the software on page 9

° Setting up the printer on page 15

° Personalizing the printer on page 17

° Paper handling on page 23
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° Printing on page 45

° Color management on page 53

° Practical printing examples on page 59

° Handling ink cartridges and printheads on page 83
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° Maintaining the printer on page 95

Troubleshooting
These chapters help you solve problems that may occur while printing and include the following topics.

° Troubleshooting paper issues on page 111

° Troubleshooting print-quality issues on page 121

° Troubleshooting ink cartridge and printhead issues on page 137

° Troubleshooting general printer issues on page 145

° Front-panel error messages on page 151

Accessories, support and specifications

These chapters, Accessories on page 105, HP Customer Care on page 153 and Printer
specifications on page 157, contain reference information, including customer care, the printer
specifications and part numbers for paper types, ink supplies and accessories.

Glossary

The Glossary on page 161 contains definitions of printing and HP terms used in this documentation.

Index

In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and Cautions

The following symbols are used in this manual to ensure the proper use of the printer and to prevent
the printer from being damaged. Follow the instructions marked with these symbols.

/A WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal
injury or death.

/A CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury
or damage to the product.

ENWW Using this guide 3



The printer's main features

Your printer is a color inkjet printer designed for printing high-quality images on paper up to 24 inches
(61 cm) . Some major features of the printer
are shown below:
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e  Print resolution of up to 2400 x 1200 optimized dpi, from a 1200 x 1200 dpi input, using the Best
print-quality option, the Maximum Detail option and photo paper

e The HP Printer Utility, see Access the HP Printer Utility on page 19, provides an easy-to-use
interface including:

° Calibration of printer

° Access to the online HP Knowledge Center
e Accurate and consistent color reproduction with automatic color calibration
e Economode for printing economically
e  Six-ink system

° Color emulations, see Printer emulation on page 56

e Paper flexibility and automatic easy load, see Paper handling on page 23, with information and
profiles accessible from the front panel and from the HP Printer Utility

The printer's main components

The following front and rear views of the printer illustrate the main components.

4 Chapter 1 Introduction ENWW



Front view

1.

2
3
4
5.
6
7
8
9

Ink cartridge

Ink cartridge slots
Blue lever
Window

Front panel
Printhead carriage
Printhead

Output tray

Paper alignment lines

10. Basket
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Rear view
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1. Spindle

Spindle holders

Quick Reference Guide holder

Sockets for communication cables and optional accessories
Hard power switch

Power cord plug in

N oo a > v b

Paper feeder

The front panel

Your printer's front panel is located on the front of the printer, in the center. It has the following important
functions:

e Assists you in troubleshooting issues
e Is used to perform certain procedures, such as cutting and unloading paper
e Displays helpful animations to guide you through procedures

o Displays up-to-date information about the status of the printer such as, the ink cartridges, the
printheads, the paper and the print jobs

e Displays warning and error messages, when appropriate, along with audio alerts to call attention
to a warning or message

e Can be used to change the values of printer settings and thus change the operation of the printer.
However, settings in the front panel are overridden by settings in the printer drivers, see Installing
the software on page 9.
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The front panel has the following components:

1. Direct access keys:

s First key Iﬂ : View ink levels, see Check the ink cartridges status on page 84

Second key m : View loaded paper, see View information about the paper on page 40

®  Third key : Unload paper, see Unload a roll on page 36 and Unload a single sheet
on page 40

®  Fourth key ‘@ : Form feed and cut, see Feed and cut the paper on page 42

2.  Menu key - Press to return to the main menu of the front-panel display. If you are already on the
main menu it will display the status screen.

3.  OKkey - To confirm an action while in a procedure or interaction. To enter in a submenu in the
menu. To select a value when given an option.

4. Back key - To go to the previous step in a procedure or interaction. To go to the upper level, or
leave the option in the menu, or when given an option.

5.  Down key - To go down in a menu or option, or to decrease a value, for example when configuring
the front-panel display contrast or the IP address.

6. Upkey - To go up in a menu or option, or to increase a value, for example when configuring the
front-panel display contrast or the IP address.

7. Cancel key - To abort a procedure or interaction.

8. Power key - To turn the printer off or on, it also has a light to indicate the printer's status. If the
power key light is off the printer is off. If the power key light is blinking green, the printer is starting
up. If the power key light is green on, the printer is on. If the power key light is amber on, the printer
is in standby. If the power key light is blinking amber, the printer needs attention.

9. LED light - Indicates the printer's status. If the LED light is solid green, the printer is ready. If it is
flashing green, the printer is busy. If it is solid amber, there is a system error. If it is flashing amber,
the printer needs attention.

10. Front-panel display - Displays errors, warnings and information on using your printer.
To highlight an item in the front-panel display, press the Up or Down key until the item is highlighted.
To select an item in the front-panel display, first highlight it and then press the OK key.

When this guide shows a series of front-panel display items like this: Item1 > ltem2 > Item3, it means
that you should select Item1, then select Iltem2, then select Item3.

Information about specific uses of the front panel can be found throughout this guide.

ENWW The front panel 7



Printer software
The following software is provided with your printer:
e The RTL and HP-GL/2 driver for Windows
e The PCL3 raster driver
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e  The HP Printer Utility, see Access the HP Printer Utility on page 19, allows you to:

0 Manage the printer including color with the HP Color Center
0 Access the HP Knowledge Center

o Update the printer's firmware, see Update the firmware on page 101

o Perform calibrations and troubleshooting

e The Embedded Web Server, runs in the printer and enables you to use a Web browser on any
computer, see Access the Embedded Web Server on page 19.

The printer's internal prints

The internal prints give various kinds of information about your printer. They can be requested from the
front panel without using a computer.

/\ CAUTION: Before requesting any internal print, make sure that paper is loaded (roll or sheet), and
that the front panel displays the Ready message. The loaded paper should be at least A3 landscape
(16.53 in or 42 cm wide); otherwise the print may be clipped.

To print any internal print, press the Menu key to return to the main menu, select the Internal Prints
menu icon .I then select the internal print you want. The following internal prints are available.
e Demo prints: show some of the capabilities of the printer

o Print drawing demo

° Print rendering demo

° Print GIS map

B NOTE: Demo prints are printed the same size as the loaded paper .

e Menu map: shows details of all the front-panel display menus
e Configuration: shows all the current front-panel display settings
e HP-GL/2 palette: shows the color or grayscale definitions in the currently selected color palette

e  Service information: provides information needed by service engineers

8 Chapter 1 Introduction ENWW



2 Installing the software

° Choose which connection method to use

° Connect directly to a computer (Windows)

e Connect to a network (Windows)

e Uninstall the printer software (\Windows)

e Connect directly to a computer (Mac OS)
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e Connect to a network (Mac OS)

e Uninstall the printer software (Mac OS)

ENWW 9



Choose which connection method to use

The following methods can be used to connect your printer.

Connection type Speed Cable length Other factors

USB 2.0 Very fast Short (5 m = 16 ft) A certified USB 2.0 cable is necessary for
reliable communication.

Fast Ethernet Very fast; varies Long (100 m = 328 ft) Requires extra equipment (switches)
according to network
traffic

Jetdirect print server Moderate; varies Long (100 m = 328 ft) Requires extra equipment (switches)
(optional accessory) according to network
traffic Provides additional features

See http://www.hp.com/go/jetdirect/ for
more details

Bf NOTE: The speed of any network connection depends on all components used in the network, which
can include network interface cards, hubs, routers, switches and cables. If any one of these components
cannot operate at high speed, you will have a low-speed connection. The speed of your network
connection can also be affected by the total amount of traffic from other devices on the network.
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Connect directly to a computer (Windows)

You can connect your printer directly to a computer by using the printer's built-in USB 2.0 socket
(supported under Windows 2000, Windows XP and later versions of Windows).

1. Do not connect the computer to the printer yet. You must first install the printer driver software
on the computer, as follows.

2. Insert the HP Start-Up Kit DVD into your DVD drive. If the DVD does not start automatically, run
the START.EXE program in the root folder of the DVD.

3. Click Install. The printer drivers and the HP Printer Ultility are installed.

4. Follow the instructions on your screen to set up the printer. The following notes help you to
understand the screens and make appropriate choices.

e When asked how the printer is connected, select Connected directly to this computer.

e If you would like to share the printer with other people connected to your network, press
the Printer Properties button in the Ready to Install window, then select the Sharing tab
and enter the name under which the printer will be shared.

e  When prompted to do so, connect your computer to the printer with a certified USB cable
(provided with the printer). Ensure that the printer is turned on.

B NOTE: You may complete the installation without connecting your printer if you prefer. To
do so, check the box marked | want to connect my printer after completing the setup
wizard.

NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables
certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this
printer.
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Printer sharing considerations
e  The HP Printer Utility must be installed on a computer before it can be used from that computer.

e Any other users sharing your directly connected printer will be able to send print jobs, but will not
be able to receive information from the printer—which affects printer alerts, printer status reports,
paper management, printer administration and troubleshooting.

X TIP: The best way to share the printer over a network is to connect the printer not to any computer,
but to the network. See Connect to a network (Windows) on page 11.

Connect to a network (Windows)
Before you begin, check your equipment:
e  The printer should be set up and on.
e The Ethernet hub or router should be on and functioning correctly.

e  All computers on the network should be on and connected to the network.
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e The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer:

1. Make a note of the IP address from the status screen on the printer's front panel (192.168.1.1 in
this example):

Ready for paper

htTp /7 mhknll
hitp: /7192.168.1.1

Fress B to enter

2. Insert the HP Start-Up Kit DVD into your computer. If the DVD does not start automatically, run the
START.EXE program in the root folder of the DVD.

3. Click Install. The printer drivers and the HP Printer Utility are installed.

4. Follow the instructions on your screen to set up the printer. The following notes help you to
understand the screens and make appropriate choices.

e When asked how the printer is connected, select Wired Networking.

e The configuration program looks for printers connected to your network. When the search is
complete, a list of printers appears. Identify your printer by its IP address and select it from
the list.

e The configuration program analyzes the network and the printer. The program detects the
network settings and suggests the settings to use when configuring the printer. It is not
normally necessary to change any of these settings, but you can do so if you wish.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed,
which helps you to try to find your printer. If you have a firewall in operation, you may have to disable it
temporarily in order to find the printer. You also have the options of searching for the printer by its URL,
IP address or MAC address.

ENWW Connect to a network (Windows) 11



Uninstall the printer software (Windows)

1. Insert the HP Start-Up Kit DVD into your DVD drive. If the DVD does not start automatically, run
the START.EXE program in the root folder of the DVD.

2. Select Install, and follow the instructions on your screen to uninstall the printer software.

Connect directly to a computer (Mac OS)

You can connect your printer directly to a computer by using the printer's built-in USB 2.0 socket.
1. Make sure the printer is either turned off, or disconnected from the computer.
Insert the HP Start-Up Kit DVD into your DVD drive.

Open the DVD icon on your desktop.

Follow the instructions on your screen. You are recommended to use the Easy Install option.
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The printer software is installed, including the printer driver and the HP Printer Utility.

2
3
4. Open the Mac OS X HP Designjet Installer icon.
5
6
7

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set
up a connection to your printer.

8. Make sure that the printer is turned on and connected to the computer with a certified USB cable
(provided with the printer).

Bf NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables
certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this printer.

9. Inthe HP Printer Setup Assistant, click Continue.

10. In the list of printers that appears, select the entry that uses the connection type USB, and click
Continue.

11. The following screen displays information about your printer's installation, where the name of the
printer can be modified. Make any changes you wish to make, and click Continue.

12. Your printer is now connected. In the Printer Queue Created screen, click Quit to exit, or Create
New Queue if you want to connect another printer.

13. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
DVD.

Sharing the printer

Ef NOTE: Printer sharing between users is supported under Mac OS X 10.4 and 10.5.

If your computer is connected to a network, you can make your directly connected printer available to
other computers on the same network.

1. Double-click the System Preferences icon on the Dock menu bar on your desktop.
2. Enable printer sharing by going to Sharing > Services > Printer Sharing.

3. Your printer now automatically appears in the list of shared printers displayed by any other
computer running Mac OS and connected to your local network.

12 Chapter 2 Installing the software ENWW
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Please bear in mind the following considerations.

e Any other users wishing to share your printer must install the printer software on their own
computers.

e Any other users sharing your directly connected printer will be able to send print jobs, but will not
be able to receive information from the printer—which affects printer alerts, printer status reports,
paper management, printer administration and troubleshooting.

e You may find that sharing your directly connected printer with other users will slow down your
computer unacceptably.

X TIP: The best way to share the printer over a network is to connect the printer not to any computer,
but to the network. See Connect to a network (Mac OS) on page 13.

Connect to a network (Mac OS)

You can connect your printer to a local area network by using the following methods:

e Bonjour/Rendezvous
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e TCP/IP

Bf NOTE: The printer does not support AppleTalk.

Before you begin, check your equipment:

e  The printer should be set up and on.

e The Ethernet hub or router should be on and functioning correctly.

e  All computers on the network should be on and connected to the network.
e The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer.

Bonjour/Rendezvous connection
1. Goto your printer's front panel and select the Connectivity menu icon , then Fast
Ethernet > View configuration. Note the mDNS service name of your printer.

2. Insert the HP Start-Up Kit DVD into your DVD drive.

Uninstall the printer software (Mac OS)
1. Insert the HP Start-Up Kit DVD into your DVD drive.
2. Open the DVD icon on your desktop.
3. Open the Mac OS X HP Designjet Installer icon.
4. Select Uninstall, and follow the instructions on your screen to uninstall the printer software.
To delete the print queue:

e Under Mac OS X 10.4 or 10.5: from the system preferences, select the Printing pane of the Print
& Fax dialog. Select the name of the printer and click the — button.

e Under Mac OS X 10.3 or 10.4: from the Print Setup utility, select the name of the printer and click
the Delete icon.

ENWW Connect to a network (Mac OS) 13



EZ NOTE: Under Mac OS X 10.4, both methods are available.
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3 Setting up the printer

° Introduction

° Turn alerts on and off

e Set Windows driver preferences
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Introduction

This chapter describes various printer settings that the printer administrator may wish to control as soon
as a new printer is assembled and ready for use.

Turn alerts on and off

Printer alerts warn you when there is a printer problem that you can correct by taking action. The alerts
are displayed by the printer's front panel, by the HP Printer Utility and by the printer driver.

You can tell the printer which kinds of alerts you would like to see (if any). To access the alert settings:
e Select Alert Settings in the Device List page of the HP Printer Utility.

e Select Alert Settings in any alert page displayed by the HP Printer Utility for Windows.

e Right-click the HP Printer Utility for Windows system tray icon, and select Alert Settings.

You can change the settings in the following ways:

e  Turn all alerts on or off.

e Turn on or off printer alerts for problems that stop the printer from printing.

e Turn on or off printer alerts for problems that do not stop the printer from printing.

e Turnon printer alerts in all circumstances, or only when you are trying to print to the printer affected
by the problem.

Set Windows driver preferences

You can change some default settings in your printer driver according to your own preferences, for
instance to set color emulation or paper-saving options. To do this, press the Start button on your
computer's screen, then select Printers and Faxes. In the Printers and Faxes window, right-click on
your printer's icon, and select Printing Preferences. Any settings you change in the Printing
Preferences window will be saved as default values.
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4 Personalizing the printer

e Turn the printer on and off

° Change the language of the front-panel display

e Access the HP Printer Utility

° Access the Embedded Web Server

° Change the language of the HP Printer Utility

° Change the language of the Embedded Web Server

° Change the sleep mode setting

e Turn the buzzer on and off

° Change the front-panel display contrast

° Change the units of measurement

e Configure network settings

° Change the graphic language setting
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Turn the printer on and off

X¥ TIP: The printer can be left powered on without wasting energy. Leaving it on improves response time
and overall system reliability. When the printer has not been used for a certain period of time (the default
time is determined by Energy Star), it saves power by going into sleep mode. However, any interaction
with the printer's front-panel display returns it to active mode, and it can resume printing immediately.
To change the sleep mode time, see Change the sleep mode setting on page 20.

Bf NOTE: In sleep mode, the printer performs maintenance service to the printheads from time-to-time.
This avoids long preparation times after long idle periods. Therefore, it is strongly recommended to leave
the printer powered on or in sleep mode to avoid wasting ink and time.

The printer has three levels of power consumption.

e  Plugged in: the power cord is plugged into the back of the printer

e Switched on: the switch at the back of the printer is in the on position
e Powered on: the Power key on the front panel shows a green light

If you wish to turn the printer on or off or reset the printer, the normal and recommended method is to
use the Power key on the front panel.

o

However, if you plan to store the printer indefinitely or the Power key does not seem to work, you are
recommended to power it off using the Power key, and then also switch off the power switch at the rear.
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To turn it back on, use the power switch at the rear.
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When the printer is powered back on, it takes about three minutes to initialize and check and prepare
the printheads. Preparing the printheads takes about one minute and 15 seconds. However, if the printer
has been off for six weeks or more, preparing the printheads could take up to 45 minutes.

Change the language of the front-panel display
There are two possible ways to change the language of the front-panel menus and messages.

e Ifyou can understand the current front-panel display language, press the Menu key to return to the
main menu and select the Setup menu icon , then Front panel options > Select language.

e If you cannot understand the current front-panel display language, start with the printer powered
off. At the front panel, press the OK key and hold it down. While holding the OK key down, press
the Power key and hold it down. Continue to hold down both keys until the green light on the right
side of the front-panel display starts flashing, and then release both keys. You can expect a delay
of about one second. If the green light starts flashing without any delay, you may need to start
again.

Whichever method you used, the language selection menu should now appear on the front-panel
display. Highlight your preferred language with the Up and Down keys, then press the OK key.

When you have selected your preferred language, turn off the printer with the Power key and then turn
it on again. The front panel will appear in the selected language.

Access the HP Printer Utility

The HP Printer Utility enables you to manage your printer from a computer with a USB, TCP/IP or
Jetdirect connection.

e Under Windows, start the HP Printer Utility from your desktop shortcut or from Start > All
Programs > Hewlett-Packard > HP Printer Utility > HP Printer Utility. This launches the HP
Printer Utility, showing the printers installed on your computer.

e Under Mac OS, launch the HP Printer Utility from your dock shortcut or by selecting
STARTUP_DISK > Library > Printers > hp > Utilities > HP Printer Utility. This launches the HP
Printer Utility Printer Selector, showing the printers installed on your computer.

Select your printer and click Select. This launches the HP Printer Utility.

If you have followed these instructions but failed to get through to the HP Printer Utility, see Cannot
access the HP Printer Utility on page 147.
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Access the Embedded Web Server

The Embedded Web Server enables you to manage your printer remotely using an ordinary Web
browser running on any computer.

To access the Embedded Web Server directly, you must have a TCP/IP connection to your printer.
However, you can access the Embedded Web Server indirectly through the HP Printer Utility, if you
connect to your printer with a USB connection.

The following browsers are known to be compatible with the Embedded Web Server:
e Internet Explorer 6 or later, for Windows

e Internet Explorer 5.2, for Mac OS X 10.3

e  Safari 2, for Mac OS X 10.4

ENWW Change the language of the front-panel display 19



To access the Embedded Web Server on any computer, open your Web browser and give the address
of your printer. You can find out the address of your printer (starting with http:) from the front-panel
display, by looking at the status screen.

Ready for paper

http: /S mnrKll
hitp://192.1668.1.1

Fress B to enter

If you have followed these instructions but failed to get through to the Embedded Web Server, see
Cannot access the Embedded Web Server on page 147.

Change the language of the HP Printer Utility

The HP Printer Utility can work in the following languages: English, Portuguese, Spanish, Catalan,
French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese.

e Under Windows, select Tools > Set Language and select a language from the list.

e Under Mac OS, the language is changed as for any other application. In System Preferences
select International and re-launch the application.

Change the language of the Embedded Web Server

The Embedded Web Server can work in the following languages: English, Portuguese, Spanish,
Catalan, French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and
Japanese. It uses whichever language you have specified in your Web browser's options. If you have
specified a language that it cannot support, it works in English.

To change the language, you must change your Web browser's language setting. For example, in
Internet Explorer version 6, go to the Tools menu and select Internet Options, Languages. Then
ensure that the language you want is at the top of the list in the dialog box.

To complete the change, you must close and reopen your Web browser.

Change the sleep mode setting
If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep
mode to save power. To change the time the printer waits before it goes into sleep mode, press the
Menu key to return to the main menu and select the Setup menu icon , then Front panel

options > Sleep mode wait time. Highlight the wait time you want and then press the OK key. You can
set the time to 30, 60, 120, 150, 180, 210 or 240 minutes.
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Turn the buzzer on and off

To turn the printer's buzzer on or off, press the Menu key to return to the main menu and select the
Setup menu icon , then Front panel options > Enable buzzer, and highlight on or off and press

the OK key. By default, the buzzer is set to on.
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Change the front-panel display contrast

To change the contrast of the front-panel display, select the Setup menu icon , then Front panel

options > Select display contrast, and enter a value using the Up or Down key. Press the OK key to
set the value. The default contrast is set to 50.

Change the units of measurement

To change the units of measurement in the front-panel display, select the Setup menu icon ,

then Front panel options > Select units, and select English or Metric. By default the units are set to
metric.

Configure network settings
To configure the same network settings from the front panel, press the Menu key to go to the main menu
and select the Connectivity menu icon . You can view and configure the following network settings.
e USB: view information about the USB connection
o JetDirect EIO: view information, configure and reset the JetDirect connection

e Advanced > Select I/0 timeout: specify the number of seconds that an idle connection is allowed
to remain open, 270 is the default value, if set to zero, the timeout is disabled

e Advanced > Allow SNMP: specify whether SNMP is permitted

e Advanced > Embedded Web Server > Allow EWS: specify whether the Embedded Web Server
is enabled

e Advanced > Web Services > Printer Utility software: view the Printer Utility software settings

e Advanced > Web Services > Color and paper management: view the color and paper
management settings

Change the graphic language setting

B NOTE: You should not need to change the default graphic language setting (Automatic), and you are
not recommended to do so.

You can change the graphic language setting from the front panel. Press the Menu key to return to the
main menu the select the Setup menu icon , then Printing preferences > Select graphic

language. Select one of the following options and press the OK key to set the value.
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e Select Automatic to let the printer determine which type of file it is receiving. This setting works
for most software applications.

e Select HP-GL/2 only if you are sending a file of that type directly to the printer, without going through
a printer driver.
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5 Paper handling

° General advice

e Load a roll onto the 24-inch spindle

e Load a roll into the 24-inch printer

e Unload aroll

° Load a single sheet

° Unload a single sheet

e View information about the paper

° Paper profiles

° Print on loaded paper

° Maintain paper

° Change the drying time

e Turn the automatic cutter on and off

° Feed and cut the paper
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General advice

/A CAUTION: Before starting a paper loading process, ensure you have enough room around the printer,
both in front and behind.

/A CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

/A CAUTION: All paper must be 11 inches (28 cm) or longer. A4 and letter paper cannot be loaded
landscape.

X¥ TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

/A CAUTION: Keep the basket closed throughout the loading process.

Load a roll onto the 24-inch spindle

/A CAUTION: Ensure the sheet tray is closed.
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1. Remove the spindle from the printer one end at a time.

/A WARNING! Do not insert your fingers into the spindle supports during the removal process.

2. The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to
mount a new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper

stop from the end of the spindle.

3. If the roll is long; rest the spindle horizontally on a table and load the roll on the table.

X TIP: You may need two people to handle a large roll.
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4. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not,
remove the roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the

spindle showing the correct orientation.

Ef NOTE: From the back of the printer, the blue stopper is inserted into the right-side holder.

Ensure both ends of the roll are as close to the spindle stops as possible.5

Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

6. Ensure the blue paper stop is pushed in as far as it goes; until both ends are against the stoppers.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls
of different paper types on different spindles. Extra spindles are available for purchase, see

Accessories on page 105.
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Load a roll into the 24-inch printer

There are two ways to load a roll. The easy loading procedure is recommended.

/A CAUTION: To start these procedures you must have a roll loaded on the spindle. See Load a roll onto
the 24-inch spindle on page 24.
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Easy loading procedure

1. Standing behind the printer, rest the spindle's black end on the left side roll holder. Do not put the
end completely into the roll holder.

3. With both hands, push the spindle into both roll holders at the same time. The spindle snaps into
place.
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4. If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll),
pull paper slightly beyond the cutting groove and use a cutter to cut a straight edge.

)

X TIP: Cut the paper as straight as possible, as uneven paper does not load correctly.

5. Insert the edge of the paper into the feeder.

/A WARNING! Do not push your fingers inside the printer's paper path.

6. Roll the spindle into the feeder until you feel resistance. The printer detects the paper and feeds it
automatically into the printer.

7. Once the paper is fed into the printer, the front-panel display asks if you are loading a roll or a
sheet. Select Roll with the Up and Down keys and press OK.
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8. Select your paper category and type.

select paper category

» Bond and Coated Faper

= Fhoto Faper

»Film

» Technical Paper

> Backlit material

» Self-Adhesive material

¥+ TIP: If you have loaded a paper type whose name does not appear in the paper list, see The
paper type is not in the driver on page 114.

9. The printer checks the alignment and measures the width.

10. Look at the front panel; you may find some instructions there.

11. When the roll is aligned, the front panel displays the Ready message and the printer is ready to
print. If the roll is not aligned, follow the instructions on the front-panel display.

12. If the paper is loose on the roll, lightly rewind from the end of the spindle until tight.

B NOTE: If you have an unexpected issue at any stage of the paper loading process, see The paper

cannot be loaded successfully on page 112.

X TIP:  When prints fall into the basket, they can be torn or get ink marks from other prints. To avoid this,

Paper menu procedure

ENWW

catch your prints as they are cut from the roll and do not stack prints in the basket. You can also turn
off the automatic cutter, see Turn the automatic cutter on and off on page 42, and release your print

using the Form feed and cut key | 9|

As an alternative you can use the paper menu to start the paper loading process.

1. Follow steps one through four of the Easy loading procedure on page 29.

2. Press the Menu key to return to the main menu, select the Paper menu icon .
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3. Select Paper load.

FPaper
Faper load

@ Unload paper

mView loaded paper

@ Change loaded paper type
® Faper types list

4. Select Load roll.

FPaper load

wmLoad roll
m Load sheet

5.  Select your paper category and type.

select paper category
» Bond and Coated Faper

» Fhoto Faper

= Film

» Technical Paper

» Backlit material

» Self-Adhesive material

X TIP: If you have loaded a paper type whose name does not appear in the paper list, see The
paper type is not in the driver on page 114.

6. Continue with step five of the easy loading process, skipping steps eight and nine.

¥ TIP:  When prints fall into the basket, they can be torn or get ink marks from other prints. To avoid this,
catch your prints as they are cut from the roll and do not stack prints in the basket. You can also turn
off the automatic cutter, see Turn the automatic cutter on and off on page 42, and release your print

using the Form feed and cut key | 4|
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Unload a roll

Before unloading a roll, check whether there is paper on the roll or if the roll is out of paper, and follow
the appropriate procedure as described below.

Unload paper key procedure with paper on the roll

If there is paper on the roll, use the following procedure.

1. Press the Unload paper key on the front panel.

2. When prompted by the front-panel display, lift the blue lever on the left.

3. When prompted by the front-panel display, lightly rewind the paper from the end of the spindle until
removed from the printer.

4.  When prompted by the front-panel display, lower the blue lever.
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Paper menu procedure with paper on the roll

If there is paper on the roll, you can also start the process from the paper menu in the front panel's main
menu.

1 Press the Menu key to return to the main menu, select the Paper menu icon .

2. Select Unload paper.

Paper
FPaper load

= Unload paper

»iew loaded paper

B Change loaded paper type
E Paper types list

3. Continue from step two of the Unload paper key process.

Roll out of paper procedure
If the end of the paper is no longer attached to the roll use the following procedure.

1. If you have already started the unload process, press the Cancel key on the front panel to cancel
that procedure.

2. Lift the blue lever on the left. If the front panel displays a warning about the lever, ignore it.

3. Pull out the paper from the printer. Pull from wherever the paper is accessible; the back of the
printer is recommended.

4. Lower the blue lever.

5. If the front panel displays a warning message, press the OK key to clear it.

Load a single sheet

There are two ways to load a sheet. The easy loading procedure is recommended.

/A CAUTION: Any loaded roll or sheet must be unloaded before loading a sheet, see Unload a roll
on page 36 or Unload a single sheet on page 40.

CAUTION: For sheets thicker than 0.5mm, you must have space behind the printer equal to the length
of the sheet.
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Easy loading procedure

1. Standing in front of the printer, open the sheet tray.

2. Insert the sheet into the feeder. Load your sheet aligned with the load line and insert until the paper
will not continue, with thicker sheets you feel resistance. The printer detects the sheet in three
seconds. A countdown begins on the front-panel display.

/A WARNING! Do not push your fingers inside the printer's paper path.

3.  After the countdown, the paper feeds into the printer. Guide the sheet into the printer; this is
especially important with thicker papers.

4. The front-panel display asks if you are loading a roll or a sheet. Select Sheet with the Up and
Down keys.

B NOTE: If you select roll, the sheet will not load.

5. Enter your paper category and type.

select paper category

= Bond and Coated Paper
» Fhoto Faper

= Film

» Technical Paper

» Backlit material

» Self-Adhesive material

¥ TIP: If you have loaded a paper type whose name does not appear in the paper list, see The
paper type is not in the driver on page 114.
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6. The printer checks the alignment and measures the sheet.

==
== >

Bf NOTE: Depending on the length of the sheet, it feeds out the front of the printer.

7. If the paper has been loaded successfully, the front panel displays the Ready message and the
printer ready to print. If the paper is not straight, follow the instructions on the front-panel display.

Bf NOTE: When correctly loaded, the sheet is in the back of the printer.

NOTE: If you have an unexpected problem at any stage of the paper loading process, see The paper
cannot be loaded successfully on page 112.

Paper menu procedure
As an alternative you can use the paper menu to start the paper loading process

1. Perform step one of the easy loading procedure.

2. Press the Menu key to return to the main menu and select the Paper menu icon .I

3. Select Paper load.

=
w Unload paper

& iew loaded paper

m Change loaded paper type
H Paper types list

per load

4. Select Load sheet.

Paper load

mLoad roll
m Load sheet
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/A CAUTION: If you select roll, the sheet will not load.
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5.  Select your paper category and type.

select paper category

= Bond and Coated Paper
» Fhoto Faper

= Film

» Technical Paper

» Backlit material

» Self-Adhesive material

X¥ TIP: If you have loaded a paper type whose name does not appear in the paper list, see The
paper type is not in the driver on page 114.

6. Continue with step two of the easy loading procedure, skipping steps four and five.

Unload a single sheet

To unload a single sheet after printing, you can simply pull the sheet free from the front of the printer.
To unload a sheet without printing, use the Unload paper key or the paper menu procedure.

Unload paper key procedure
1.

Press the Unload paper key on the front panel.

2. The sheet unloads out the front of the printer, either catch it manually or allow it to fall in the basket.
Paper menu procedure
You can also unload a sheet from the paper menu.

1. Press the Menu key to return to the main menu and select the Paper menu icon .

2. Select Unload paper. The sheet unloads out of the front of the printer, either catch it manually or
allow it to fall in the basket.

Faper
Faper load

e Unload paper

»iew loaded paper

H Change loaded paper type
® Paper types list

View information about the paper
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To view the loaded paper information, press the View loaded paper key m on the front panel.

You can also select the Paper menu icon and then View loaded paper.
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The following information is displayed on the front panel:

e Roll or sheet status

e Paper type you have selected

e  Width of the paper in millimeters (estimated)

e Length of the sheet in millimeters (estimated)

e Color calibration status

e Paper advance calibration status

If no paper is loaded, the message Out of paper is displayed.

The same information is displayed in the HP Printer Utility for Windows, on the Supplies page.

B NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 128.

Paper profiles

Each supported paper type has its own characteristics. For optimum print-quality, the printer changes
the way it prints on each different paper type. For example, some may need more ink and some may
require a longer drying time. So the printer must be given a description of the requirements of each
paper type. This description is called the “media” or “paper” profile. The paper profile contains the ICC
profile, which describes the color characteristics of the paper; it also contains information on other
characteristics and requirements of the paper that are not directly related to color. Existing paper profiles
for your printer are already installed in the printer's software.

However, as it is inconvenient to scroll through a list of all paper types available, your printer only
contains paper profiles for the most commonly used paper types. If you have a paper type for which
your printer has no profile, you cannot select that paper type in the front-panel display.

There are two ways to assign a profile for a new paper type.

e Use an HP factory paper profile by selecting the closest category and type in the front panel or the
HP Printer Utility, see The paper type is not in the driver on page 114.

Bf NOTE: Colors may not be accurate. This method is not recommended for high-quality prints.

e Download the correct paper profile from: http://www.hp.com/go/T620/paperpresets/.

B NOTE: HP only provides profiles for HP paper types. If you do not find the paper profile you want
on the Web, you may find that it has been added to the latest firmware for your printer. You can
check the firmware release notes for information, see Update the firmware on page 101.

Print on loaded paper

To print a job on whichever paper is loaded in the printer, select Any in the Paper Type option of your
printer driver.

e Inthe Windows driver dialog: select the Paper/Quality tab, then select Any in the Paper Type
drop-down list.
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e Inthe Mac OS Print dialog: select the Paper Type/Quality panel, then select Any in the Paper
Type drop-down list.

Bf NOTE: Any is the default Paper Type selection.
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Maintain paper
To maintain paper quality, follow the recommendations below.
e  Store rolls covered by another piece of paper or cloth
e  Store cut sheets covered and clean or brush them before loading them in the printer
e Clean input and output platens and cut sheet tray

e Always keep the window of your printer closed

Bf NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 128.

Change the drying time

You may wish to change the drying time setting to suit special printing conditions such as multiple prints
where time is of higher importance or when you need to be sure ink is dry before handling.

Select the Setup menu icon , then Print retrieval > Select drying time. You can select:

e Extended, to set a longer than recommended time to ensure ink is completely dry
e Optimal, to set the default and recommended time for your selected paper
e Reduced, to set a shorter than recommended time when quality is of lower importance

e None, to disable the drying time and remove your print as soon as it finishes printing

/\ CAUTION: Ifthe ink is not dry when the print is removed it could leave ink in the output tray and marks
on the print.

Ef NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right
away due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts
the paper and then performs the printhead maintenance. However, if the dry time is greater than zero,
the printer does not cut the paper until after the printhead maintenance has completed, even if you press

the Form feed and cut key 'g] .

Turn the automatic cutter on and off

To turn the printer's paper cutter on or off, go to the front panel and press the Menu key to return to the
main menu. Select the Setup menu icon , then Print retrieval > Enable cutter and change the

cutter option.

Bf NOTE: When cutting between jobs is disabled the paper can still be cut while it is loaded. To completely
disable the cutter, use the HP Color Center within the HP Printer Utility, and customize your paper to
make it uncuttable.

NOTE: To cut rolled paper while the automatic cutter is disabled, see Feed and cut the paper
on page 42.

Feed and cut the paper

To feed and cut the paper when the automatic cutter has been disabled, press the Form feed and cut
key 'g] on the front panel. The paper advances and the printer makes a straight cut on the front edge.
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i NOTE: The printer may not cut the paper directly after pressing the Form feed and cut key ‘@ , as

each time a print is printed the printheads are serviced and the paper cannot be cut until the process
completes.

Remove the cut piece from the output tray.

"‘/_‘,,«\’

/\ CAUTION: If strips or short prints are left in the output tray the printer could jam.

Bf NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 128.
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e  Select print quality

° Select paper size
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° Print with shortcuts

° Rescale a print

° Change the treatment of overlapping lines

° Print a draft

° High-quality printing

° Print in gray shades

e  Reprint last printed job
e Use paper economically
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Select print quality

The printer has various print-quality options because best-quality printing requires some loss of speed,
while fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and
speed. With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: Best, Normal and Fast. If you select Fast, you
can also select Economode, which uses a lower rendering resolution and consumes less ink. It
therefore increases printing speed even further, but reduces print quality. Economode can be selected
only from the custom options (not from the slider).

There is also a supplementary custom option that may have an effect on print quality: Maximum
detail. See High-quality printing on page 50.

B NOTE: Inthe Windows driver dialog, the rendering resolution for your job is displayed in the Custom
Print Quality Options dialog box (select Custom options and then Settings). In the Mac OS Print dialog,
it is displayed in the Summary panel.

You can select print-quality options in the following ways:

e In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
If you select Standard Options, you will see a simple slider with which you can select speed or
quality. If you select Custom Options, you will see the more specific options described above.

e In the Mac OS Print dialog: go to the Paper Type/Quality panel and select Paper. If you
select Standard quality options, you will see a simple slider with which you can select speed or
quality. If you select Custom quality options, you will see the more specific options described
above.

®  Using the front panel: select the Setup menu icon , then Printing preferences > Print
quality.

Ef NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the
front panel.

Bf NOTE: You cannotchange the print quality of pages that the printer is already receiving or has already
received (even if they have not started to print yet).

Select paper size

The paper size can be specified in the following ways.

Bf NOTE: The paper size specified here should be the paper size in which the document was created.
It is possible to rescale the document to a different size for printing. See Rescale a print on page 48.

e Inthe Windows driver dialog: select the Paper/Quality tab, then select your paper size from the
Document Size list.

e Inthe Mac OS Page Setup dialog: select your printer from the Format for list, then select your
paper size from the Paper Size list.

®  Using the front panel: select the Setup menu icon , then Printing preferences > Paper
options > Select paper size.

B NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front
panel.
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Custom paper sizes
To choose a non-standard paper size not shown in the list of paper sizes:
° Under Windows, there are two different ways:

o In the driver dialog, click the Custom button in the Paper/Quality tab, then specify the name
and the dimensions of your new paper size, then click Save to save your new paper size. To
see your new custom size in the list of custom sizes, you need to exit the printer properties,
then reenter them (and use the More button if necessary).

Ef NOTE: The driver will not allow you to create a paper size whose width exceeds its length.

° From the Start menu, select Printers and Faxes, then from the File menu select Server
Properties. In the Forms tab, check the Create a new form box, specify the name and
dimensions of the new form, then click Save Form.

e Under Mac OS X 10.4: select Paper Size > Manage Custom Sizes in the Page Setup dialog.
e Under Mac OS X 10.3: select Settings > Custom Paper Size from the Page Setup dialog.

Select margins options

By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the
paper (increased to 17 mm at the foot of cut-sheet paper). However, you can change this behavior in
several ways.

e Inthe Windows driver dialog: select the Paper/Quality tab and then the Margins/Layout button.
e Inthe Mac OS Print dialog: select the Paper Type/Quality panel and then Layout.

You will then see at least some of the following options.

Bf NOTE: Under Mac OS, the available margins options depend on the paper size selected in the Page
Setup dialog.

e Standard. Yourimage will be printed on a page of the size you have selected, with a narrow margin
between the edges of the image and the edges of the paper. The image should be small enough
to fit between the margins.

e Oversize. Your image will be printed on a page slightly larger than the size you have selected. If
you cut off the margins, you will be left with a page of the size you selected, with no margins
remaining between your image and the edges of the paper.

e Clip Contents By Margins. Your image will be printed on a page of the size you have selected,
with a narrow margin between the edges of the image and the edges of the paper. In this case, if
the image is the same size as the page, the printer assumes that the extreme edges of the image
are either white or unimportant, and do not need to be printed. This may be useful when your image
already contains a border.

Print with shortcuts

The printer driver provides many options that can be set to different values when printing a particular
job. A printing shortcut stores the values of all these options that are appropriate for a particular kind of
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job, so that you can set them all with a single click. Some settings (such as paper size, paper source
and orientation) may be overridden by the values provided by your application.

To use a shortcut, select the Printing Shortcuts tab in the Windows driver dialog.

Bf NOTE: Shortcuts are available only under Windows.
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You can see a list of available shortcuts; select the one that matches the kind of job you want to print.

The driver options are now adjusted to suit your job. You can either print immediately, or examine the

settings to check that you agree with them. If you like, you can select a shortcut and then change some
of its settings manually.

X TIP: Check at least the settings that you can see in the Printing Shortcuts tab: the document size,
orientation, etc.

The Factory Defaults shortcut contains the printer's default settings. When you click on it, it sets all
options to their default values.

Printing shortcuts can be customized to your particular needs. To create your own shortcut:
1. Select the shortcut that comes closest to satisfying your requirements.

2. Change any value in the Printing Shortcuts tab and/or other tabs.

3. Save the new printing shortcut.

If you decide later that you no longer want a shortcut, you can delete it.

Rescale a print

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size
(normally larger). This may be useful:

e If your software does not support large formats

e Ifyourfile is too large for the printer's memory—in this case, you can reduce the paper size in your
software and then scale it up again using the front-panel option
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You can rescale an image in the following ways:
o Inthe Windows driver dialog: go to the Features tab and look at the Resizing Options section.

0 The Print document on option adjusts the image size to the paper size you have selected.
For example, if you have selected ISO A2 as the paper size and you print an A3-sized image,
it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a
larger image to fit the A4 size.

o The % of actual size option enlarges the printable area of the original paper size (the page
minus the margins) by the percentage indicated, then adds the margins to create the output
paper size.

e Inthe Mac OS Print dialog: select the Paper Handling panel, then Scale to fit paper size, and
select the paper size to which you want to scale the image. If you want to increase the size of the
image, make sure that the Scale down only box is unchecked.

®  Using the front panel: select the Setup menu icon , then Printing preferences > Paper
options > Resize.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet,
otherwise the image will be clipped.

Change the treatment of overlapping lines

Bf NOTE: This topic applies only when printing an HP-GL/2 job.

The merge option controls the overlapping lines in an image. There are two settings:
e  Off: where the lines cross, only the color of the top line is printed.
e  On: where the lines cross, the colors of the two lines merge.

To turn merge on, go to the front panel and select the Setup menu icon , then Printing

preferences > HP-GL/2 options > Enable merge. You can set the merge option from your software
in some applications. Settings in your software override the front-panel settings.

Print a draft

ENWW

You can specify fast draft-quality printing in the following ways:

e Inthe Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
Move the print-quality slider to the extreme left ('Speed").

e Inthe Mac OS Print dialog: go to the Paper Type/Quality panel and select Paper, then move
the print-quality slider to the extreme left ('Speed’).

®  Using the front panel: select the Setup menu icon , then Printing preferences > Print
quality > Select quality level > Fast.
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You can specify even faster draft-quality printing by using Economode, as follows. This is intended
mainly for documents containing only text and line drawings.

e Inthe Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
Select Custom Options, then set the quality level to Fast and check the Economode box.

e In the Mac OS Print dialog: go to the Paper Type/Quality panel and select Paper, then set the
quality options to Custom, set quality to Fast and check the Economode box.

®  Using the front panel: select the Setup menu icon , then Printing preferences > Print

quality > Enable economode.

Ef NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front
panel.

High-quality printing
You can specify high-quality printing in the following ways:

e Inthe Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
Move the print-quality slider to the extreme right ('Quality").

e In the Mac OS Print dialog: go to the Paper Type/Quality panel and select Paper, then move
the print-quality slider to the extreme right ('Quality').

®  Using the front panel: select the Setup menu icon , then Printing preferences > Print

quality > Select quality level > Best.

Ef NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front
panel.

If you have a high-resolution image

If your image has a resolution greater than the rendering resolution (which you can see in the Custom
Print Quality Options box under Windows), print sharpness may be improved by selecting the Maximum
Detail option. This option is available only if you are printing on glossy paper and you have selected
Best print quality.

e In the driver dialog (Mac OS Print dialog): select Custom instead of Standard print-quality
options, then check the Maximum Detail box.

®  Using the front panel: select the Setup menu icon , then Printing preferences > Print

quality > Enable maximum detail.

Ef NOTE: The Maximum Detail option results in slower printing with photo papers, but it does notincrease
the amount of ink used.
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Print in gray shades

You can convert all colors in your image to shades of gray in the following ways:
e Inyour application program: many programs provide this option.

e Inthe Windows driver dialog: go to the Color tab and look at the Color Options section.
Select Print in Grayscale. You can also select Print in pure black and white if you want only
black and white, without gray shades.

e Inthe Mac OS Print dialog: go to the Paper Type/Quality panel and select Color, then select
Print In Grayscale. You can also select Pure Black and White if you want only black and white,
without gray shades.

Reprint last printed job

You can reprint the last job printed from the front panel. Select the Job management menu icon @]

then Reprint last job.

Ef NOTE: You cannot use this method for PCL3 jobs. To reprint old jobs that are PCL3, you may be able

to use your operating system's printer spooler, if you have already set the spooler to save old jobs. This
facility depends on your operating system.
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Use paper economically

You may be able to save some roll paper by using the following options:

In the Windows driver dialog: select the Features tab and then Remove top/bottom blank
areas and/or Rotate by 90 degrees.

In the Mac OS Print dialog: select the Paper Type/Quality panel, then Paper, then Remove Top/
Bottom Blank Areas.

Use ink economically

Here are some recommendations for making economical use of ink.

For draft prints, use plain paper and move the print-quality slider to the left end of the scale
('Speed'). For further economy, select custom print quality options, then select Fast and
Economode.

Clean the printheads only when needed, and clean only those printheads that need cleaning.
Cleaning the printheads can be useful, but it uses a small amount of ink.

Leave the printer permanently turned on so that it can maintain the printheads in good condition
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not
done, the printer may need to use much more ink later to restore the health of the printheads.

Wide prints make more efficient use of ink than narrow prints, because printhead maintenance
uses some ink, and its frequency is related to the number of passes made by the printheads.
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Introduction

HP Designjet T620 printers have been engineered with advanced hardware and software features to
ensure predictable and dependable results.

e  Color calibration for consistent colors.
e One gray and two black inks provide neutral grays on all paper types.
e The Photo Black ink provides pure blacks when printing on photo papers.

e  Color emulation of other HP Designjet printers.

How colors are represented

All devices that display color use a color model to represent color in numerical terms. Most monitors
use the RGB (Red-Green-Blue) color model, while most printers use the CMYK (Cyan-Magenta-Yellow-
blacK) color model.

An image can be converted from one color model to another, but in general the conversion is not perfect.
Your printer uses the RGB color model: the same color model that is used by your monitor.
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This simplifies but does not completely solve the problem of matching colors. Each device represents
colors a little differently from another device, even if they use the same color model. However, software
can adjust the colors in an image according to the characteristics of the particular device, using a color
profile of the device, in order to achieve correct colors.

A summary of the color management process

To get the accurate and consistent colors that you want, you should follow these steps for each paper
type that you use.

1. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and
then (see Color calibration on page 54). In addition, you may wish to calibrate immediately before
a particularly important print job for which color consistency is vital.

2. When printing, select the correct color profile for the paper type you are using.

Color calibration

Color calibration enables your printer to produce consistent colors with the particular printheads, inks
and paper type that you are using, and under your particular environmental conditions. After color
calibration, you can expect to get similar prints from any two different printers situated in different
geographical locations.

Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of
the following circumstances:

e  Whenever a printhead is replaced

e Whenever a new paper type is introduced that has not yet been calibrated with the current set of
printheads

e  Whenever the environmental conditions (temperature and humidity) change significantly
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You can check the color calibration status of the currently loaded paper at any time by pressing the
View loaded paper key on the front panel. The status may be one of the following:

e PENDING: the paper has not been calibrated.

Bf NOTE: Whenever you update the printer's firmware, the color calibration status of all papers is
reset to PENDING.

e OBSOLETE: the paper has been calibrated, but the calibration is now out of date because a
printhead has been replaced, and should be repeated.

e DONE: the paper has been calibrated, and the calibration is up to date.

e DISABLED: this paper cannot be calibrated.

Bf NOTE: Color calibration cannot be performed on plain paper, nor on any kind of transparent
material.

You can also check the color calibration status by using the HP Printer Utility.

You can start color calibration in the following ways:
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° From the HP Color Center: select Calibrate Your Printer.

®  From the front panel: select the Image Quality Maintenance menu icon , then Calibrate

color.

The calibration process is fully automatic and can be performed unattended after you have loaded paper
of the type you wish to calibrate—which should be A3 or any larger size.

The process takes about 3—5 minutes and consists of the following steps.

1. A calibration chart is printed, which contains patches of each ink used in your printer.
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2. The chartis allowed to dry for a period of time that depends on the paper type, so that the colors
have time to stabilize.

3. The chart is scanned and measured.

4. From the measurements, the printer calculates the necessary correction factors to apply for
consistent color printing on that paper type. It also calculates the maximum amount of each ink
that can be applied to the paper.

Color management from printer drivers

Color management options

The aim of color management is to reproduce colors as accurately as possible on all devices: so that,
when you print an image, you see very similar colors as when you view the same image on your monitor.
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There are two basic approaches to color management for your printer:

e Application-Managed Colors: in this case your application program must convert the colors of
your image to the color space of your printer and paper type, using the ICC profile embedded in
the image and the ICC profile of your printer and paper type.

e Printer-Managed Colors: in this case your application program sends your image to the printer
without any color conversion, and the printer converts the colors to its own color space. Color
management is done using a set of stored color tables; ICC profiles are not used. This method is
somewhat less versatile than the previous methods, but is a little simpler and faster, and can
produce good results with standard HP paper types.

Ef NOTE: There are only two color spaces that the printer can convert to its own color space using
the stored color tables: Adobe RGB and sRGB if you are using Windows, Adobe RGB and
ColorSync if you are using Mac OS.

ColorSync is the Mac OS built-in Color Management System; so, in fact, when selecting ColorSync
it is the built-in color management part of Mac OS that is performing the color management, and
it is done based on the ICC profiles of specified paper type. ColorSync is available with the PCL
driver only.
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You are recommended to consult the Knowledge Center at http://www.hp.com/go/T620/
knowledgecenter/ to see how to use the color management options of your particular application.

To choose between Application-Managed Colors and Printer-Managed Colors:
e In the Windows driver dialog: select the Color tab.
e Inthe Mac OS Print dialog: select the Paper Type/Quality panel, then Color.

e In some applications: you can make this choice in the application.

Printer emulation

If you want to print a particular job and to see approximately the same colors that you would get from
printing the same job on a different HP Designjet printer, you can use the emulation mode provided by
your printer.

Bf NOTE: This option is available only when printing an HP-GL/2 job. It will work correctly only when
printing on plain, coated or heavyweight coated paper.

e Inthe Windows HP-GL/2 driver dialog: select the Color tab, then Printer Managed Colors, then
select Printer Emulation from the Source Profile list. You can then select from the Emulated Printer
list.

e Inthe Mac OS Print dialog: select the Paper Type/Quality panel, then Color > Printer Managed
Colors > Emulated Printer.

Color adjustment options

The aim of color management is to print accurate colors. If you perform color management correctly,
then you should be able to print accurate colors with no need of any manual color adjustments.

However, manual adjustments may be useful in the following situations:
e If your color management is not working correctly for some reason
e If you want colors that are subjectively pleasing rather than accurate

The printer driver provides different adjustment facilities depending on whether you are printing in color
or in grayscale. If you are printing in pure black and white, there are no color adjustment options.
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Printing in color
You can adjust the colors of your print in similar ways under Windows and Mac OS:

e Inthe Windows driver dialog: select the Color tab, ensure that the Advanced color
adjustments box is checked, then press the Settings button beside it.

e Inthe Mac OS Print dialog: select the Paper Type/Quality panel, then Lightness and Hue.

Under either operating system, you will then be able to make adjustments using a lightness slider and
three color sliders.
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e The lightness slider simply makes the whole print lighter or darker.
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e The color sliders can be used to fade or emphasize each of the primary colors in the print. The
primary colors may be red, green and blue; or cyan, magenta and yellow; depending on the color
model used in the image.

The Reset button restores each slider to its default central position.

Printing in grayscale
You can adjust the gray balance of your print in similar ways under Windows and Mac OS:

e Inthe Windows driver dialog: select the Color tab, ensure that the Advanced color
adjustments box is checked, then press the Settings button beside it.

e Inthe Mac OS Print dialog: select the Paper Type/Quality panel, then Gray balance.

Under either operating system, you will then be able to make adjustments using separate controls for
highlights, midtones and shadows.
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e The lightness slider simply makes the whole print lighter or darker. This slider is available under
Windows in the same window as the other grayscale controls; it is available under Mac OS by
selecting Lightness and Hue.

e The zone definition sliders can be used to define what you mean by highlight, midtone and shadow.

e The other controls for highlight, midtone and shadow can be used to adjust the gray balance of
highlights, midtones and shadows respectively.
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The Reset button restores each control to its default setting.

Color management from the front panel

You can color-calibrate the loaded paper type from the front panel by selecting the Image Quality
Maintenance menu icon , then Calibrate color. See Color calibration on page 54.

The other color options in the front panel can all be found by selecting the Setup menu icon ,

then Printing preferences > Color options.

Ef NOTE: These front panel settings can all be overridden by the printer driver.

e Color/Grayscale: you can choose to print in color or in shades of gray. Default: Print in color.

e Select RGB source profile: you can choose from a selection of RGB source profiles recognized
by the printer. Default: sSRGB (HP).

e Emulate printer: you can choose to emulate a different HP Designjet printer. Default: Off (no
printer emulation).

X TIP: If you have old HP-GL/2 files made for a different HP Designjet printer, you can send them
to the printer and use the front panel to turn on the appropriate emulation mode.
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8 Practical printing examples

° Print a draft for revision with the correct scale

° Print a project

° Print a presentation

° Print and scale from Microsoft Office
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Print a draft for revision with the correct scale

This section demonstrates how to print a draft for revision with the correct scale from Adobe Acrobat.

Using Adobe Acrobat

1. In the Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to
check the plot size.
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2. Select File > Print.
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B NOTE: The page size will not be automatically selected according to the drawing size.
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3. Inorder to keep the scale, set Page Scaling to None (which is not the default setting).
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Stahs  Ready Crginnls sl Foume:

Tre  HP Dot TE) 44 HPGLD [Bocremens ana 2eamps |

™ oo Papes Soute b POF page sge

L Documet 3532100
I~ Pt ok s blach g §50 1100
Cppl CR

4. Press the Properties button and then select the Paper/Quality tab.
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5. Choose whatever Document Size and Print Quality you want to use. If you want to define a new
custom paper size, press the Custom button.
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6. Select the Features tab, and then Autorotate.
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7. Click OK, and check that the print preview in the Print dialog box seems correct.
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Print a project

This section demonstrates how to print a project from AutoCAD.
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Using HP Instant Printing

e Make sure Use HP Instant Printing has been selected. To print, click the Print icon in the toolbar
or select File > Print. Choose your preferred printing settings and click OK.

HP Instant Printing - Bracket3D.dwf o x|
Printer: [HP DesignjetTea0  HPGL2 =

[V Use HP Instant Printing
[¥ Da not print 30 models
Status: Ready

Type: HP DesignjetT620  HPGL2
Location: LPTL:

Comments:

Paper size:

e Alternatively, Use HP Instant Printing can be launched directly from its own toolbar icon. In this
case, it starts immediately, using the settings you defined previously.
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Using AutoCAD

1. The AutoCAD window shows the Model tab followed by a tab for each layout. Normally one of the
layouts is printed rather than the model.
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2. Select File > Plot.
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3. You can see further options by pressing the circular button in the lower right corner of the window.

Phat style tabls (pen assignments)

] Nore vl /s

Fiok options
Pkt in background

[#] Phot with plot styles
[]Plot paperspace Last

[ 1Hde paperspace cbiects
et stamp on

[ save changes to kayout

Diraweing crientation

I Portra
(%) Landscape B
[ 1Plot upside-down

o [ comen J[_ue @

Bf NOTE: The Quality option here does not refer to the final print quality but to the quality of AutoCAD
viewport objects that are sent for printing.
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4. Press the Properties button.
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5. Select the Device and Document Settings tab, and press the Custom Properties button.
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6. Select the Paper/Quality tab, then select the paper type that you intend to use.
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7.
8.

9.

Select the print quality (your own choice between speed and quality of printing).

If you intend to print on roll paper, you must decide where the printer should cut the paper. Press
the Margins/Layout button.

Layout and Margins aption 3 2%

" Clip contents by mangine.

LI Borderless
Image Endargamant
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Layout and Margins option

[ Layout Mode
£+ print with manging
~Layout Options

" Standard
 Qversize
{+ [Cip contents by manging

LI Borderless
Image Enlargamant

& futomatically by printer

o I1nunlty i Applcatian

Usage

Uses this setting when the contents bo be printed have white borders
and a size equal to thak of the paper you have selected in the driver.
The printer vall use the white border For its marging and you vl get &
page of size aqual bo that which is seleckad in the driver.
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11. Press the OK button and save your configuration changes to a PC3 file.
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Print a presentation

This section demonstrates how to print a presentation from AutoCAD and from Photoshop.

Using AutoCAD
1. Open the AutoCAD file.
2. Select Print from Layout.

3. Select File > Plot.
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4. Ensure that the correct printer is selected, then press the Properties button.
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5. Select the Device and Document Settings tab, and press the Custom Properties button.
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6. Select the Paper/Quality tab, then select the paper type that you intend to use.
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7.  Select the print quality (your own choice between speed and quality of printing).

8. If you intend to print on roll paper, you must decide where the printer should cut the paper. Press
the Margins/Layout button.

Layout and Margins option

& futomaticaly by printer

£ 1ol i Anpcatian

9.

Layout and Margins option

[ Layout Mode
£+ print with manging
~Layout Options

" Standard
 Qversize
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LI Borderless
i~ Image Enlargemant
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Usage

Uses this setting when the contents bo be printed have white borders
and a size equal to thak of the paper you have selected in the driver.
The printer vall use the white border For its marging and you vl get &
page of size aqual bo that which is seleckad in the driver.
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10. Select the Features tab, then select Autorotate. Autorotation can help to avoid wasting paper.
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11. Press the OK button and save your configuration changes to a PC3 file.
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Using Adobe Photoshop

1. Select File > Page Setup > Printer, select your printer and click OK.
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2. Choose from the available paper sizes.

If you do not find the paper size that you intend to use, select Printer > Properties > Paper/
Quality > Custom > Paper Size. Enter the width, the length and the name of your custom paper
size. Press the Save and OK buttons.
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3. Select File > Print with Preview.

x
— Pustion Cem. 1]
Top: [0955 [inches = | cancel |
Lefts [0 [inches =
Dang
Ry
Scaed Print Size - Fawer Optiors.
mhm T~ Scde to Fit Media
et [254  [mches =] }t
with: [17813 [nches =]
¥ Shaw Boundng Box
IF | Print Sclocted drca

= Document  (Profle: sRGH IECH1966-2.1) |
" Proof (Profie:nifa)

— Options

74 Chapter 8

P ‘simate 8lock ik

Color Handing: [ Let Printer Datermine Coors I ) |
Erintes prifie: | viorlng RGE - SRGE IEC61966-2.1 | 2]

Rendering Intent: | Relative Colormatne =] |7 lack poinl, Comperation |

Proof Sotun Protet I Works d |

Practical printing examples

ENWW



4. Select Print > Properties.

5.
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6. Press the Margins/Layout button.

The default image enlargement method is Automatically by printer. The option Manually in
application can be used when you want to control the amount of enlargement precisely.

7. Inthe Color tab, the default color management option is Printer Managed Colors, and this is the
correct option because you have already selected Let Printer Determine Colors in Photoshop.
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Print and scale from Microsoft Office

This section demonstrates how to print and scale from Microsoft Office.
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Using PowerPoint

1. Select File > Print, then select the Name of your printer.
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2. Select Properties > Features > Print document on to scale the document to a particular size.
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3. Select the Paper/Quality tab, then select Paper Source and Paper Type.
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4. Select Margins/Layout, then select Clip contents by margins to keep the size.

Layout and Margins option 2
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Using Project
1. Select File > Page Setup > Print.
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2. Select your printer's name, then Close.
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3. Select Page Setup, and choose the Paper Size you want.
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4. Select Options to go to the printer driver. The default options in the Paper/Quality tab are probably
suitable: Paper Source: Automatically Select and Paper Type: Any.
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5. Select Features > Print document on to scale the document to a particular size. Alternatively,
you can scale the document in Project.
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Using Excel

1. Select File > Page Setup > Print. Select your printer's name, then click Close.
it T

Mame: ;HPOeeigﬂe! Te20 HPGL2 :] Fropeies... '
Status:  Ready
Type:  HPDesignist 7620 HPGL2
‘Where:  LpT1:
Comment: 1 Print to fie
i+ Print rangs LCopies
o] Number of copies: |1 =
c oy I
ol i |2 [ Collate
€ Selection

e

2. Select File > Page Setup, and choose the Paper Size you want.
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3. Select Options to go to the printer driver.
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4. Select the Paper/Quality tab, where you can select Paper Source, Paper Type and Print

Quality.
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5. Select Features > Print document on to scale the document to a particular size. Alternatively,
you can scale the document in Excel.
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Handling ink cartridges and printheads

e About the ink cartridges

° Check the ink cartridges status

° Remove an ink cartridge

° Insert an ink cartridge

° About the printheads

° Check the printhead status

° Remove a printhead

° Insert a printhead
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About the ink cartridges

Ink cartridges store the ink and are connected to the printheads, which distribute the ink on the paper.
To purchase additional cartridges, see Accessories on page 105.

/A CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive
devices (see the Glossary on page 161). Avoid touching pins, leads and circuitry.

Check the ink cartridges status
To view the ink levels of your ink cartridges, press the View ink level key on the front panel.

To get more information on your ink cartridges, you can use the front panel ink menu or the HP Printer
Utility.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages
on page 138.

Ink menu procedure
1. Press the Menu key to return to the main menu and select the Ink menu icon , then Ink
cartridge information.
2. Select the cartridge on which you want information.
3. The front panel displays:
e Color
e  Product name
e  Product number
e  Serial number
e Status
e Inklevel, if known
e  Total ink capacity in milliliters
e Expiration date

e  Warranty status
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° Manufacturer

HP Printer Utility procedures

e In the HP Printer Utility for Windows, go to the Overview tab, each cartridge's status is under
Supplies Status > Cartridges.

e Inthe HP Printer Utility for Mac OS, select Printer Status in the Information group.
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Remove an ink cartridge

There are two occasions when you need to remove an ink cartridge.

e Theink cartridge is very low and you want to replace it with a full cartridge for unattended printing
(you can use up the remaining ink in the first cartridge at a more convenient time).

e The ink cartridge is empty or faulty, and you must replace it to continue printing.

/A CAUTION: Do not try to remove an ink cartridge while printing.
CAUTION: Remove an ink cartridge only if you are ready to insert another one.

CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

1 Press the Menu key to return to the main menu and select the Ink menu icon , then Replace

ink cartridges.

Ink

i ink levels

> Replace ink cartridges

» Replace printheads

B Ink cartridge information
Printhead information

2. Open the ink cartridge cover on the left-hand side of the printer. All six inks, gray, photo black,
matte black, yellow, magenta and cyan, are on the left-hand side.
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3.  Grip the cartridge you wish to remove.
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4.  Pull the cartridge straight up.

—

B NOTE: Avoid touching the end of the cartridge that is inserted into the printer, as there may be
ink on the connection.

NOTE: Avoid storing partially used ink cartridges.

5. The front-panel display identifies the missing ink cartridge.

Insert an ink cartridge

1. Before removing the cartridge from its wrapping, shake it vigorously.

2. Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters
(in these illustrations, M for magenta) marking the empty slot, matches the letter or letters on the

cartridge label.

3. Insert the ink cartridge into its slot.
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4. Push the cartridge into the slot until it snaps into position. You should hear a beep and see
confirmation that the cartridge has been inserted.

If you have difficulty, see Cannot insert an ink cartridge on page 138.

5. When all cartridges have been inserted, close the cover.

6. The front-panel display confirms that all cartridges have been correctly inserted, press the OK key
on the front panel.

About the printheads

The printheads are connected to the ink cartridges and jet ink onto the paper.

/A CAUTION: Observe precautions when handling printheads because they are ESD-sensitive devices
(see the Glossary on page 161). Avoid touching pins, leads and circuitry.
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Check the printhead status

The printer automatically checks and services the printheads after each print. Follow the steps below
to get more information on your printheads.

1. Press the Menu key to return to the main menu and select the Ink menu icon , then Printhead

information.

2. Select the printhead on which you want information.

3. The front panel displays:

Colors

Product name
Product number
Serial number

Status, see Front-panel error messages on page 151

Volume of ink it has used

Warranty status

You can also get most of this information without leaving your computer by using the HP Printer Utility.

For an explanation of the printhead status messages, see Printhead status messages on page 144.

If the warranty status is See warranty note, this indicates that non-HP ink is being used. See the HP
Legal Information document provided with your printer for details of the warranty implications.

Remove a printhead

/A CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.
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/A CAUTION: Printhead replacement must be performed with the printer powered on.

1.

ENWW

Press the Menu key to return to the main menu and select the Ink menu icon , then Replace
printheads.

Ink

e ink levels
» Replace ink cartridges
= Feplace printh

B Ink cartridge information
Printhead information

The printer moves the carriage into the correct position.

CAUTION: If the carriage is left in the removal position for more than three minutes without
inserting or removing any printheads, it tries to move back to its normal position in the right-hand
end.

When the carriage has stopped moving, the front-panel display asks you to open the window.

Locate the carriage on the right side of the printer.

Pull the handle up and toward you to release the wire loop.

Remove a printhead 89
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6. Push the handle back to raise the lid.

7.

8.

=)
=
Q
=
Q
©
=
=]
-
=3
(1]
Q
o
"

9.
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10. Pull the blue handle upward until the printhead is released from the carriage.

/A CAUTION: Do not pull abruptly because this can damage the printhead.

11. The front-panel display identifies the missing printhead.

Insert a printhead

1. Remove the orange protective caps by pulling them down.
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2. The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check
that the colored label on the printhead matches the colored label of the carriage slot into which the
printhead is to be inserted.
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3. Insert the new printhead into its correct slot in the carriage.

/A CAUTION: Insert the printhead slowly and vertically, straight down. It may be damaged if you
insert it too fast, or at an angle, or if you rotate it as you insert it.

4. Push down as indicated by the arrow shown below.

/A CAUTION: When installing the new printhead there may be some resistance, so you need to
press it down firmly but smoothly. You should hear a beep and see confirmation on the front-panel
display that the printhead has been inserted. If you have difficulty, see Cannot insert a printhead

on page 138.

5. Insert all other printheads that need to be installed, and close the carriage lid.
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6. Ensure the end of the blue handle catches the wire loop on the near side of the carriage.

7. Lower the handle to rest on the carriage cover.

When all the printheads have been inserted correctly and are accepted by the printer, the printer
beeps.

B NOTE: If the printer does not beep when you insert the printhead and the Replace message
appears on the front-panel display, the printhead may need to be reinserted.

8. Close the window.

9. The front-panel display confirms that all printheads are correctly inserted. The printer starts
checking and preparing the printheads. The default routine process, when all printheads are
changed, takes 10 minutes. If the printer finds problems in preparing the printheads, it takes longer,
up to 45 minutes. For a single printhead insertion, the times vary between 2 and 40 minutes. After
all printheads are checked and prepared, the printhead realignment procedure runs automatically
if paper is loaded, see Align the printheads on page 142.
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ENWW

Maintaining the printer

° Check printer status

° Clean the exterior of the printer

° Replace the cutter

° Maintain the ink cartridges

° Move or store the printer

° Update the firmware

° Update the software

° Printer maintenance Kkits
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Check printer status

You can check the current status of the printer in various ways:

o If you start the HP Printer Utility and select your printer, you see a page of information describing
the status of the printer and its paper and ink supplies.

e If you access the Embedded Web Server, you see information about the general status of the
printer.

e The status screen of the printer's front panel notifies you of any current problems affecting the
printer as a whole. You can also request information about:

o

The currently loaded paper, with the View loaded paper key m

o

The ink levels, with the View ink levels key m

° The ink cartridges, by selecting the Ink menu icon and then Ink cartridge information

° The printheads, by selecting the Ink menu icon and then Printhead information

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal
operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid
soap.

/A WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before
you clean it. Do not let water get inside the printer.

/A CAUTION: Do not use abrasive cleaners on the printer.

Replace the cutter

The cutter may need to be replaced once or twice during the life of the printer, depending on the total
amount and thickness of paper used. The front panel advises when replacement is due. If you do not
replace the cutter immediately, the printer continues working normally, but the front panel continues to
remind you about the cutter.

To replace the cutter:

1. If there is paper loaded in the printer, unload it.

2. Atthe front panel, select the Setup menu icon , then Resets > Reset cutter life counter.

3. After a brief pause, the printer turns itself off. The printhead carriage is parked on the right-hand
side of the printer, and the cutter on the left-hand side.

/A WARNING! There is a risk of electric shock if you attempt to replace the cutter with the printer
turned on.
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4. Lift the ink cartridge cover on the left-hand side of the printer.

5. Press the button behind the ink cartridges to release the cover of the left-hand end of the printer.

6. Remove the left end cover.
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7.  Unscrew and remove the cutter stop using the TORX PLUS screwdriver provided with the new
cutter. The screw is captive and will not fall out.

9. Take the new cutter from the maintenance kit and move the plunger at the top slowly back and
forth within its housing to check that it moves freely.
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10. Slide the new cutter into position on the cutter rail.

The two wheels on the bottom of the cutter should engage the central ridge on the cutter rail, and
the two bushing guides should fit into the groove in the upper part of the cutter rail.

L,
L)

Check that the cutter runs smoothly up and down the rail. You can leave it anywhere on the rail;
the printer will park it correctly later.

11. Fit the cutter stop onto the end of the cutter rail, holding it there with one hand while you tighten
the screw with the screwdriver in your other hand.
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12. Put the left end cover back on the printer, aligning the protrusions with the holes in the printer.

14. At the front panel, turn the printer back on. The printer checks that the cutter has been correctly
installed. Look at the front panel and follow its instructions if there is any problem.

Maintain the ink cartridges

During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to
maintain the best print quality, replace a cartridge when it reaches its expiration date. The printer's front
panel notifies you when any cartridge reaches its expiration date.

You can also check a cartridge's expiration date at any time: see Check printer status on page 96.

See also Handling ink cartridges and printheads on page 83.

Move or store the printer

If you need to move or store the printer, prepare it correctly to avoid possible damage to it. To prepare
the printer, follow the instructions below.

1. Do not remove the ink cartridges or printheads.
2. Make sure that no paper is loaded.

3. Make sure that the printer is idle.
4

Disconnect any cables connecting the printer to a network or a computer.
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If you need to leave the printer turned off for a long time, follow the additional steps below.
1. Turn off the power using the Power key on the front panel.

2. Also turn off the power switch at the rear of the printer.

3. Disconnect the printer's power cable.

4. Before transporting the printer, secure the rear tray in the closed position with tape. Otherwise, the
tray could open and perhaps break and fall out of the printer.

CAUTION: If you turn the printer upside down, ink could escape into the printer and cause serious
damage.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and
prepare the printheads. Preparing the printheads normally takes just over a minute. However, if the
printer has been off for a six weeks or more, preparing the printheads could take up to 45 minutes.

CAUTION: If the printer remains off for a long period of time, the printheads may become unusable.
In this case, you need to replace the printheads with new ones.

TIP: Because preparing and purging the printheads uses both time and ink, you are strongly
recommended to leave the printer always on or in sleep mode, whenever possible, to maintain the health
of the printheads. In both cases, the printer wakes up from time to time to maintain the printheads. Thus
you can avoid going through lengthy preparation processes before using your printer.

Update the firmware

ENWW

The printer's various functions are controlled by software that resides in the printer, otherwise known
as firmware.

From time to time firmware updates will be available from Hewlett-Packard. These updates increase the
printer's functionality and enhance its features.

Firmware updates can be downloaded from the Internet and installed in your printer in the following
ways; you can choose whichever you find most convenient.

e Usingthe HP Printer Utility under Windows, select your printer, the Support tab and then Firmware
Update.

e Using the HP Printer Utility under Mac OS, select Firmware Update in the Support group.

e Using your printer's Embedded Web Server, select the Main tab and then Firmware update.

NOTE: If you are using an HP Jetdirect print server to connect to a network, the HP Printer Utility will
not be available, so you will need to use the Embedded Web Server.

In each case, follow the instructions on your screen to download the firmware file and store it on your
printer. Then select the downloaded file and click Update.

Update the firmware 101
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If you experience very slow progress while uploading the firmware file to the printer, the reason could
be that you are using a proxy server. In that case, try bypassing the proxy server and accessing the
Embedded Web Server directly.

e InInternet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and check the Bypass proxy server for local addresses box. Alternatively, for more
precise control, click the Advanced button and add the printer's IP address to the list of exceptions,
for which the proxy server is not used.

e In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change
Settings button. Add the printer's IP address or its domain name to the list of exceptions, for which
the proxy server is not used.

The firmware includes a set of the most commonly used paper profiles. Extra paper profiles can be
downloaded separately; see Paper profiles on page 41.

Update the software

To update the printer driver and other software for any HP Designjet printer, go to http://www.hp.com/
go/T620/drivers/.

If your operating system is Windows, HP Software Update regularly offers to update your software
automatically.

Printer maintenance kits

Four maintenance kits are available for your printer, containing components that may need to be
replaced after long use. When one of them is needed, a message is displayed on the front panel and
by the HP Printer Utility.

When you see the message, you should contact HP Support (see Contact HP Support on page 156)
and request the maintenance kit. Three of the kits are installed by service engineers only; the fourth
consists of a replacement cutter, which you can install yourself (see Replace the cutter on page 96).
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11 Accessories

Accessories

° How to order supplies and accessories

° Introduction to the accessories
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How to order supplies and accessories

There are two alternative ways to order supplies or accessories for your printer:

° Visit http://www.hp.com/go/T620/accessories/ on the Web.

>
0
0
o
o
o
o
=
o
7]

e Contact HP Support (see Contact HP Support on page 156).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies

The following ink supplies can be ordered for your printer.

Table 11-1 Ink cartridges

Cartridge Part number
HP 72 69 ml Photo Black Ink Cartridge C9397A
HP 72 69 ml Cyan Ink Cartridge C9398A
HP 72 69 ml Magenta Ink Cartridge C9399A
HP 72 69 ml Yellow Ink Cartridge C9400A
HP 72 69 ml Gray Ink Cartridge C9401A
HP 72 130 ml Matte Black Ink Cartridge C9403A
HP 72 130 ml Photo Black Ink Cartridge C9370A
HP 72 130 ml Cyan Ink Cartridge C9371A
HP 72 130 ml Magenta Ink Cartridge C9372A
HP 72 130 ml Yellow Ink Cartridge C9373A
HP 72 130 ml Gray Ink Cartridge C9374A

Table 11-2 Printheads

Printhead Part number

HP 72 Gray & Photo Black Printhead C9380A

HP 72 Magenta & Cyan Printhead C9383A

HP 72 Matte Black & Yellow Printhead C9384A
Order paper

The following paper types are currently provided for use with your printer.

Bf NOTE: This listis likely to change over the course of time. For the latest information, see
http://www.hp.com/go/T620/accessories/.

NOTE: Paper types that HP does not support may nevertheless be compatible with your printer.

Key to availability:
e (A)indicates papers available in Asia (excluding Japan)

e (C)indicates papers available in China
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e (E) indicates papers available in Europe, the Middle East and Africa
e (J)indicates papers available in Japan
e (L) indicates papers available in Latin America

e (N)indicates papers available in North America

Accessories

If the part number is not followed by parentheses, the paper is available in all regions.

Table 11-3 Roll paper

Paper type g/m? Length Width Part numbers

HP Bond and Coated Paper

HP Universal Inkjet Bond Paper 80 150 ft=45.7m 23.39 in =594 mm (A1) QB8003A (AJ)
24 in =610 mm Q1396A
300ft=914m 23.39in =594 mm (A1) QB8004A (EAJ)
HP Bright White Inkjet Bond Paper 90 150 ft=45.7 m 16.54 in = 420 mm (A2) Q1446A (J)
23.39in =594 mm (A1) Q1445A (EJ)
24 in =610 mm C1860A (LN),
C6035A (AEJ)
HP Universal Coated Paper 95 150 ft =45.7 m 24in =610 mm Q1404A (AEJN)
HP Coated Paper 90 150 ft=45.7m 16.54 in =420 mm (A2) Q1443A (J)
18 in =458 mm Q7897A (EJN)

23.39in = 594 mm (A1) Q1442A (EJ)

24 in =610 mm C6019B

HP Universal Heavyweight Coated 120 100 ft = 30.5 m 24in =610 mm Q1412A (AEJN)
Paper
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Table 11-3 Roll paper (continued)

Paper type g/m? Length Width Part numbers
HP Heavyweight Coated Paper 131 100 ft=30.5m 24 in =610 mm C6029C (AEJN)
HP Super Heavyweight Plus Matte 210 100 ft =30.5m 24 in =610 mm Q6626A (AEJN)
Paper
HP Colored Paper Yellow 295.3ft=90m 23.39in =594 mm (A1) Q6596A (E)
HP Technical Paper
HP Natural Tracing Paper 90 150 ft=45.7m 16.54 in =420 mm (A2) Q1440A (J)
23.39in =594 mm (A1) Q1439A (J)
24 in =610 mm C3869A
HP Translucent Bond 67 150 ft=45.7m 24 in =610 mm C3860A (AJN)
HP Vellum 75 150 ft=45.7m 24in =610 mm C3862A (N)
HP Film (Technical and Graphic)
HP Clear Film 174 75ft=229m 24in =610 mm C3876A (AEJN)
HP Matte Film 160 125ft=38.1m 24in =610 mm 51642A (AEJN)
HP Photographic Paper
HP Universal Instant-Dry Photo 190 100 ft=30.5m 24 in =610 mm Q6574A
Gloss
HP Universal Instant-Dry Photo 190 100 ft =30.5m 24 in =610 mm Q6579A

Semi-Gloss

TIP: The dye inks used by your printer will fade very quickly on instant-dry photo papers. If you plan to display the prints for
more than two weeks, you should laminate them to achieve longer life.

HP Premium Plus Photo Gloss 286 50ft=152m 24in=610 mm Q5488A
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Table 11-3 Roll paper (continued)

Paper type g/m? Length Width Part numbers
HP Premium Plus Photo Satin 286 50ft=152m 18 in =458 mm Q7920A
24in=610 mm Q5491A
HP Universal High-Gloss Photo 190 100 ft = 30.5 m 24 in =610 mm Q1426A (AEJN)
Paper
HP Universal Semi-Gloss Photo 190 100 ft=30.5m 24in=610 mm Q1420A (AEJN)
Paper
Table 11-4 Sheet paper

Paper type g/m? Length Width Part numbers
HP Bond and Coated Paper
HP Coated Paper 90 24in =610 mm 18 in =457 mm Q1961A (AEJN)
HP Photographic Paper
HP Premium Plus Photo Gloss 286 19in =483 mm 13in =330 mm Q5486A

24in =610 mm 18in =457 mm Q5487A
HP Premium Plus Photo Satin 286 19in =483 mm 13in =330 mm Q5489A

24in =610 mm 18in =457 mm Q5490A

Order accessories

The following accessories can be ordered for your printer.

Name

Product number

HP Designjet T620 24in Stand

Q6663A

ENWW
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Name Product number

HP Designjet T620 24in Spindle Q6700A

HP Jetdirect 635n IPv6/IPsec Print Server J7961A
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Introduction to the accessories
Stand

The printer stand is used to support the printer and the basket, which collects prints as they emerge
from the printer. The main alternative to the stand is to put the printer on a desk.

The height of the stand is 668 mm.
The weight of the stand is 10.12 kg (24 inch).

Spindle
With extra spindles, you can change rapidly from one paper type to another.

Jetdirect print server

Jetdirect print servers provide the ability to connect your printer to a local area network.

X TIP: If you use a Jetdirect print server, you will not be able to use the HP Printer Utility.
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Troubleshooting paper issues

e The paper cannot be loaded successfully

e The paper type is not in the driver

e The paper has jammed

° The printer displays out of paper when paper is available

° Prints do not fall neatly into the basket

e The sheet stays in the printer when the print has been completed

e The paper is cut when the print has been completed

e The cutter does not cut well

e Therollis loose on the spindle

° A strip stays on the output tray and generates jams

° Recalibrate the paper advance
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The paper cannot be loaded successfully

Ensure no paper is loaded.
Ensure the paper is far enough inside the printer, you should feel the printer grab the paper.

Do not attempt to straighten the paper during the aligning process, unless instructed to do so by
the front-panel display. The printer automatically attempts to straighten the paper.

The paper may be crumpled, or warped, or may have irregular edges.

General unsuccessful roll load issues

If the paper does not load, the leading edge of the paper may not be straight or clean and needs
to be trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary
even with a new roll of paper.

Ensure the roll ends are tight against the spindle ends.

Check that the spindle is correctly inserted.

Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.
Check that all roll end plugs have been removed.

Check that the paper is wound tightly on the roll.

Do not touch the roll or paper at during the alignment process.

Unsuccessful roll load with 24-inch printer

On a 24-inch printer, if the paper has not been inserted straight, the front panel displays the following
instructions.

1.

o g M v

When prompted by the front-panel display, lift the blue lever on the left. The printer attempts to
straighten the roll.

When prompted by the front-panel display, lower the blue lever. The printer checks the alignment.
If the roll is aligned, the printer measures the width and you are now ready to print.

If the roll is still not aligned, the front panel displays an error and instructions.
When prompted by the front-panel display, lift the blue lever on the left.
Rewind the roll from the end of the spindle until the edge is on the blue line.
Press OK, on the front panel.

When prompted by the front-panel display, lower the lever. The printer checks the alignment. If the
roll is aligned, the printer measures the width and you are now ready to print.

If the roll is still not aligned, the front panel displays an error and instructions to start again at step
three.

If you would like to start the load process again, cancel the process on the front panel and rewind
the roll from the end of the spindle until the edge is removed from the printer.
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Unsuccessful sheet load

Paper loading error messages

ENWW

e  Guide the sheet, especially thick papers, when the printer initially feeds the sheet.

e Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-
panel display. The printer automatically attempts to straighten the sheet.

e Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

If the sheet is not caught by the printer, the front-panel display asks you to push paper further into the
printer, and tries to feed the paper again.

If the sheet is caught by the printer but is not inserted straight, the front panel displays the following

instructions.

1. When prompted by the front-panel display, lift the blue lever on the left.

Adjust the sheet to align with the front and right side blue lines.

2
3. Once the sheet is aligned, press OK on the front panel.
4

When prompted by the front-panel display, lower the blue lever. The printer checks the alignment.
If the sheet is aligned, the printer measures the sheet and feed it out the back into the roll feed.

You are now ready to print.

If the sheet is still not aligned, the front panel displays an error and instructions to start again.

If you would like to start the load process again, cancel the process on the front panel and the
printer ejects the sheet out the front.

Here is a list of front-panel display messages related to paper loading, with the suggested corrective

action.

front-panel display message

Suggested action

Paper incorrectly loaded

The paper has not been loaded correctly; the edge was not aligned with the load
guide. Lift the blue lever, remove paper and lower lever.

Paper not found

During the paper load process the printer did not detect any paper. Ensure the paper
is inserted fully and is not transparent.

Paper loaded with too much skew

During the paper load process the printer detected that the paper had too much
skew. Follow the instructions on the front-panel display.

The paper cannot be loaded successfully 113

Paper issues



)
Q)

T
(1)
=
7]
(7]
c
(1]
(7]

front-panel display message

Suggested action

Paper too small

During the load process the printer detected that the paper is too narrow or too short
to be loaded in the printer. Press the Cancel key to stop the load process. See
Functional specifications on page 158.

Paper too big

During the load process the printer has detected that the paper is either too wide or
too long (sheet only) to be loaded correctly. Press the Cancel key to stop the load
process. See Functional specifications on page 158.

Paper loose around core

The end of the roll has become loose around the core. Tighten the paper to the core
or insert a new roll.

Lever lifted

During the load process the blue lever was lifted. This prevents the printer from
loading the paper. Follow the instructions on the front-panel display.

The paper type is not in the driver

To work with a paper not in the driver, you can use your paper as one of the profiles already in the driver,
however, you must identify whether your paper is transparent or translucent, glossy or matte.

Bf NOTE: For glossy paper, it is important to use a glossy paper type, as matte black ink does not print

well on glossy paper.

Transparent or translucent paper

If your paper is a transparent film (for example, a transparency), select paper type Film > Transparent/

Clear film.

If your paper is a translucent paper (for example, technical paper), select paper type Technical
paper > Natural Tracing Paper, Vellum or Translucent bond.

Glossy paper

If your paper is a photo paper, use the Photo Paper category. For glossy or high-gloss paper select
paper type Photo Gloss Paper. For Semi-gloss, Satin, Pearl or Luster finishes, select paper type Semi-

gloss/Satin Paper.

To increase gamut on photo paper, select paper type HP Universal High-Gloss Photo Paper or HP
Universal Semi-Gloss Photo Paper, depending on the finish.

Matte Paper

Your paper type selection for matte paper depends on the paper’s ink absorption capacity. To select a
paper category and type, first identify if your paper is general purpose or photographic. Then select the

recommended paper types.

General-purpose paper

e  For thin papers (< 90 g/m?) uncoated papers (for example plain paper or bright white paper) select
paper type Bond and Coated Paper > Plain Paper.

e For light coated papers (<110 g/m?), select paper type Bond and Coated Paper > HP Coated

Paper.

e For heavyweight coated papers (<200 g/m?), select paper type Bond and Coated Paper >

Heavyweight Coated Paper.

e  For cockle-free very thick coated papers (> 200 g/m?), select paper type Bond and Coated
Paper > Super Heavyweight Coated Paper.
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/\ CAUTION: Only use this option if you are sure your paper does not wrinkle when printed.

Photographic paper
For photographic paper, select paper type Photo Paper > Photo Matte Paper.

Black ink is easily removed when touched

This happens when your paper is incompatible with matte black ink. To use non-matte black ink, select
paper type Photo Paper > Photo Gloss Paper.

After printing, the paper has wrinkles or there is too much ink

This happens when too much ink is used. To use less ink, select a thinner category. Matte paper
categories from thinnest to thickest are:

e Plain Paper

Paper issues

e Coated Paper
e Heavyweight Coated Paper
e  Super Heavyweight Coated Paper

For other image quality problems, see Troubleshooting print-quality issues on page 121.

The paper has jammed

When a paper jam occurs, you normally see the Possible paper jam message in the front-panel display.

Power off the printer at the front panel and also switch it off at the rear.
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2.  Open the window.
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3. Try to move the printhead carriage out of the way.

4. Lift the blue lever as far up as it will go.
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6. Standing behind the printer, rewind the roll or pull the cut sheet from the printer. If you cannot see
the paper, return to the front of the printer and remove it from the output tray.

/A CAUTION: Do not move the paper sideways, as it could damage the printer.
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7.  Carefully remove all small pieces of paper.

8. Lower the blue lever.
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9. Close window.

11. Reload the roll, or load a new sheet see Paper handling on page 23.

Bf NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the
procedure and carefully remove all pieces of paper.
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The printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper.
If possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the basket

e Ensure the basket is correctly installed.
e Ensure the basket is open.
e  Ensure the basket not full.

e Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll,
or remove prints manually as they are completed.

The sheet stays in the printer when the print has been
completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time
on page 42. If the paper is only partially ejected after the drying time, gently pull the sheet out of the

printer. If the automatic cutter is disabled, use the Form feed and cut key 'gl on the front panel, see

Feed and cut the paper on page 42.

The paper is cut when the print has been completed

By default the printer cuts the paper after the drying time has been completed, see Change the drying
time on page 42. You can disable the cutter, see Turn the automatic cutter on and off on page 42.

The cutter does not cut well

By default the printer is set to automatically cut the paper after the drying time has been completed.

If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any
obstacles.

If the cutter is turned off, the Form feed and cut key 'gl only advances the paper. Use this key to move

the print far enough out of the front of the printer, until it is convenient to manually cut with a straight
edge or scissors.

The roll is loose on the spindle

The roll may need to be replaced or reloaded. If your roll has a three-inch cardboard core, ensure the
core adaptors supplied with the printer have been installed, see Load a roll onto the 24-inch spindle

on page 24.

A strip stays on the output tray and generates jams

If a small piece of paper (200 mm or smaller) has been cut, such as before (if new roll) and after

the Form feed and cut key 'gl has been pressed, the cut strip remains in the output

tray. Only when the printer is not working, reach in the tray and remove the strip.

118 Chapter 12 Troubleshooting paper issues ENWW



Recalibrate the paper advance

Accurate paper advance is important to image quality because it is part of controlling the proper
placement of dots on the paper. If the paper is not advanced the proper distance between printhead
passes, light or dark bands appear in the print and image grain may increase.

Paper issues

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you
select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing.
However, if you are not satisfied with the default calibration of your paper, you may need to recalibrate
the rate at which the paper advances. See Troubleshooting print-quality issues on page 121 for steps
to determine if paper advance calibration will solve your issue.

You can check the paper advance calibration status of the currently loaded paper at any time by pressing

the View loaded paper key m on the front panel. The status may be one of the following.

e DEFAULT: This status appears when loading any paper that has not been calibrated. HP papers
in the Front Panel have been optimized by default and unless you experience image quality
problems in your printed image such as banding or graininess it is not recommended to recalibrate
the paper advance.

e OK: This status indicates that the loaded paper has been calibrated before. However you may need
to repeat the calibration if you experience image quality problems such as banding or graininess
in your printed image.

= NOTE: Whenever you update the printer’s firmware, the paper advance calibration values are
reset to factory default, see Update the firmware on page 101.

/A CAUTION: Transparent papers and films must be calibrated using Image Quality Maintenance menu
icon , then Paper advance calibration > Adjust paper advance, from step four in the Recalibrating

the paper advance procedure.

Recalibrating the paper advance procedure

1. Press the Menu key to return to the main menu and select the Image Quality Maintenance menu
icon , then Paper advance calibration > Calibrate paper advance. The printer automatically

recalibrates the paper advance and prints a paper advance calibration image.

2. Wait until the front panel displays the status screen and re-print your print.

Bf NOTE: The recalibration procedure takes approximately three minutes. Do not worry about the
paper advance calibration image. The front-panel display shows any errors in the process.

If you are satisfied with your print continue using this calibration for your paper type. If you see
improvement in your print, continue with step three. If you are dissatisfied with the recalibration,
return to the default calibration, see Return to default calibration on page 120.
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3. If you would like to fine-tune the calibration or are using a transparent paper, press the Menu key
to return to the main menu and select the Image Quality Maintenance menu icon , then Paper

advance calibration > Adjust paper advance.

4. Select the percentage of change from -100% to 100%. To correct light banding, decrease the
percentage. To correct dark banding, increase the percentage.

5. Press the OK key on the front panel, to save the value.

6.  Wait until the front panel displays the status screen and re-print your print.

Return to default calibration

Returning to the default calibration sets all the corrections made by the paper advance calibration to
zero. To return to the default paper advance calibration value, you must reset the calibration.

1. Press the Menu key to return to the main menu and select the Image Quality Maintenance menu
icon , then Paper advance calibration > Reset paper advance.
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2. Wait until the front panel displays the operation has completed successfully before pressing the
back key to return to the main menu.
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13 Troubleshooting print-quality issues

° General advice

° Print quality troubleshooting wizard

° Horizontal lines across the image (banding)

° Lines are too thick, too thin or missing

e Lines appear stepped or jagged

° Lines print double or in the wrong colors

° Lines are discontinuous

° Lines are blurred

° Line lengths are inaccurate

° The whole image is blurry or grainy

e The paper is not flat

e The printis scuffed or scratched

N
[«2)
=
N
L
>
=
©
=
g
]
c
=
o

° Ink marks on the paper

° Black ink comes off when you touch the print

° Edges of objects are stepped or not sharp

° Edges of objects are darker than expected

° Horizontal lines at the end of a cut sheet print

e Vertical lines of different colors

e White spots on the print

° Colors are inaccurate

° Colors are fading

e The image is incomplete (clipped at the bottom)

e Theimage is clipped

e Some objects are missing from the printed image

e A PDF file is clipped or objects are missing

e The Image Diagnostics Print

° If you still have a problem
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General advice

When you have any print-quality problem:

To achieve the best performance from your printer, use only genuine manufacturer's supplies and
accessories, whose reliability and performance have been thoroughly tested to give trouble-free
performance and best-quality prints. For details of recommended papers, see Order paper

on page 106.

Make sure that the paper type selected in the front panel is the same as the paper type loaded into
the printer. To check this, use the View loaded paper key m on the front panel. At the same time,

check that the paper type has been calibrated. Also make sure that the paper type selected in your
software is the same as the paper type loaded into the printer.

CAUTION: If you have the wrong paper type selected, you could experience poor print quality
and incorrect colors, and perhaps even damage to the printheads.

Check that you are using the most appropriate print-quality settings for your purposes (see
Printing on page 45). You are likely to see lower print quality if you have moved the print-quality
slider to the 'Speed' end of the scale, or set the custom quality level to Fast.

Check that your environmental conditions (temperature, humidity) are in the recommended range.
See Environmental specifications on page 159.

Check that your ink cartridges and printheads have not passed their expiration dates: see Maintain
the ink cartridges on page 100.

Print quality troubleshooting wizard

The Print Quality Troubleshooting Wizard can help with the following problems:

Horizontal lines across the image (banding)
The whole image is blurry or grainy
Lines are too thick, too thin or missing

Colors are inaccurate

To start the wizard:

From the HP Printer Utility under Windows: go to the Support tab, and select Print quality
troubleshooting.

From the HP Printer Utility for Mac OS: select Print quality troubleshooting in the Support
group.

From the Embedded Web Server: select Troubleshooting, then select Print quality
troubleshooting.
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Alternatively, or if you have other print quality problems, you can continue reading this chapter.

Horizontal lines across the im

If your printed image suffers from added horizontal lines as shown (the color may vary):

panel and in your software. To check on the front panel, use the View loaded paper key

age (banding)
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Check that the paper type you have loaded corresponds to the paper type selected in the front

!

Check that you are using appropriate print-quality settings for your purposes (see Printing

on page 45). In some cases, you can overcome a print-quality problem merely by selecting a higher
print-quality level. For instance, if you have set the Print Quality slider to Speed, try setting it to
Quality. If you change the print-quality settings, you may wish to reprint your job at this point in

case the problem has been solved.

Print the Image Diagnostics Print. See The Image Diagnostics Print on page 133.

[

If the printheads are working correctly, go to the front panel and press the View loaded paper key
to see the paper advance calibration status. If the status is DEFAULT, try performing paper

advance calibration: see Recalibrate the paper advance on page 119.

If the problem persists despite all the above actions, contact your customer service representative for

further support.
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Lines are too thick, too thin or missing

—— -—
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front

panel and in your software. To check on the front panel, use the View loaded paper key m .

2. Check that you are using appropriate print-quality settings for your purposes (see Printing
on page 45). Select the custom print-quality options in the driver dialog (Mac OS Print dialog), and
try turning on the Maximum detail option (if available). You may wish to reprint your job at this
point in case the problem has been solved.

3. If the resolution of your image is greater than the printing resolution, you may notice a loss of line
quality. If you are using the PCL or HP-GL/2 driver for Windows, you can find the Max. Application
Resolution option in the driver dialog's Advanced tab, under Document Options > Printer
Features. If you change this option, you may wish to reprint your job at this pointin case the problem
has been solved.

4. Iflines are too thin or missing, print the Image Diagnostics Print. See The Image Diagnostics
Print on page 133.

5 Ifthe problem remains, go to the front panel and select the Ink menu icon , then Printhead

information to see the printhead alignment status. If the status is PENDING, you should align the
printheads. See Align the printheads on page 142. After alignment, you may wish to reprint your
job in case the problem has been solved.

Go to the front panel and press the View loaded paper key m to see the paper advance calibration

status. If the status is DEFAULT, you should perform paper advance calibration: see Recalibrate
the paper advance on page 119.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

Lines appear stepped or jagged

If lines in your image appear stepped or jagged when printed:

1. The problem may be inherent in the image. Try to improve the image with the application you are
using to edit it.

2. Check that you are using appropriate print-quality settings. See Printing on page 45.
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3. Select the custom print-quality options in the driver dialog (Mac OS Print dialog), and turn on the
Maximum detail option (if available).

4. If you are using the PCL or HP-GL/2 driver for Windows, you can change your image rendering
resolution to 300 ppi or 600 ppi depending on your printing needs. You can find the Max.
Application Resolution option in the driver dialog's Advanced tab, under Document Options
> Printer Features.

Lines print double or in the wrong colors

This problem can have various visible symptoms:

e Colored lines are printed double, in different colors.

AN\
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e The borders of colored blocks are wrongly colored.
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To correct this kind of problem:

1.  Reseat the printheads by removing them and then reinserting them. See Remove a printhead
on page 88 and Insert a printhead on page 91.

2. Align the printheads. See Align the printheads on page 142.

Lines are discontinuous

If your lines are broken in the following way:
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Check that you are using appropriate print-quality settings. See Printing on page 45.

Reseat the printheads by removing them and then reinserting them. See Remove a printhead
on page 88 and Insert a printhead on page 91.

Align the printheads. See Align the printheads on page 142.

Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1.

Check that your environmental conditions (temperature, humidity) are suitable for high-quality
printing. See Environmental specifications on page 159.

Check that the paper type selected in the front panel is the same as the paper type you are using.
To check on the front panel, use the View loaded paper key m .

Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP Super
Heavyweight Plus Matte Paper.

Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

If you are using glossy paper, try changing to a different type of glossy paper.

Align the printheads. See Align the printheads on page 142.
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Line lengths are inaccurate

If you have measured your printed lines and find that the lengths are not sufficiently accurate for your
purposes, you can try to improve line length accuracy in the following ways.

1. Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional

specifications on page 158.

Polyester film is about ten times more dimensionally stable than paper. However, using film that is
thinner or thicker than HP Matte Film will reduce line length accuracy.

Set the Print Quality slider to Quality.

o ~ 0N

advance on page 119.

The whole image is blurry or grainy
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Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).
Load the roll of film and let it rest for five minutes before printing.

If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper

1. Check that the paper type you have loaded corresponds to the paper type selected in the front

panel and in your software. To check on the front panel, use the View loaded paper key m .

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 45). In some
cases, you can overcome a print-quality problem merely by selecting a higher print-quality level.
For instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you change
the print-quality settings, you may wish to reprint your job at this pointin case the problem has been

solved.

4. Go to the front panel and select the Ink menu icon , then Printhead information to see the

printhead alignment status. If the status is PENDING, you should align the printheads. See Align
the printheads on page 142. After alignment, you may wish to reprint your job in case the problem

has been solved.

Go to the front panel and press the View loaded paper key

[@

to see the paper advance calibration

status. If the status is DEFAULT, you should perform paper advance calibration: see Recalibrate

the paper advance on page 119.
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If the problem persists despite all the above actions, contact your customer service representative for
further support.

The paper is not flat

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely
to see defects in the printed image, such as vertical stripes. This can happen when you use thin paper
that becomes saturated with ink.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front

panel and in your software. To check on the front panel, use the View loaded paper key m .
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2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super
Heavyweight Plus Matte Paper.

3. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

The print is scuffed or scratched

The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object.
This is particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after
printing, depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:
e Handle prints carefully.
e Avoid stacking prints on top of each other.

e Disable the automatic cutter before printing, so that the print will not fall into the basket. See Turn
the automatic cutter on and off on page 42. Alternatively, leave a sheet of paper in the basket so
that freshly printed sheets do not make direct contact with the basket.
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Ink marks on the paper

This problem can occur for several different reasons.

Horizontal smears on the front of coated paper

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the
printheads move over the paper, the printheads may come into contact with the paper and smear the
printed image. This problem is normally seen only on cut sheets of paper (not on roll paper).

Whenever you notice this problem, cancel the printing job immediately. Press the Cancel key and also
cancel the job from your computer application. Soaked paper can damage the printheads.

Try the following suggestions to avoid this problem:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front

panel and in your software. To check on the front panel, use the View loaded paper key m .

2. Use a recommended paper type (see Order paper on page 106) and the correct print settings.
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3. If using sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may
affect performance.

4. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper and HP Super
Heavyweight Plus Matte Paper.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

6. Try to increase the margins by relocating the image to the center of the page using your software
application.

Ink marks on the back of the paper

Ink residues on the platen are likely to mark the back of the paper.

Clean the platen with a soft cloth. Clean each rib separately without touching the foam between the ribs.

Black ink comes off when you touch the print

This problem may be caused by printing with matte black ink on glossy paper. The printer will not use
matte black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you
can select Photo Glossy Paper as the paper type (in the Photo Paper category).
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Edges of objects are stepped or not sharp

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set
the print-quality slider to Quality in the driver dialog (Mac OS Print dialog), select the custom print-quality
options, and try setting the quality level to Normal. See Printing on page 45.

Edges of objects are darker than expected

i
)
!
If edges of objects seem darker than expected, and you have already set the print-quality slider to

Quality in the driver dialog (Mac OS Print dialog), select the custom print-quality options, and try setting
the quality level to Normal. See Printing on page 45.
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Horizontal lines at the end of a cut sheet print

This type of defect affects only the end of a print, within approximately 30 mm of the trailing edge of the
paper. You may see some very thin horizontal lines across the print.

To avoid this problem:

1. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 133.

2. Consider printing with roll paper.

3. Consider using larger margins around your image.

Vertical lines of different colors

If your print has vertical bands of different colors along it:

1. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight
Coated Paper and HP Super Heavyweight Paper. See Order paper on page 106.

2. Try using higher print-quality settings (see Printing on page 45). For instance, if you have set the
Print Quality slider to Speed, try setting it to Quality.
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White spots on the print

You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating
material. To avoid this problem:

1. Trycleaning the paper manually with a brush before printing, to remove any loose fibers or particles.
2. Always keep the cover of your printer closed.

3. Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate

If the colors of your print do not match your expectations, try the following:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key m . At
the same time, check the color calibration status. If the status is PENDING or OBSOLETE, you

should perform color calibration: see Color calibration on page 54. If you have made any changes,
you may wish to reprint your job in case the problem has been solved.
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2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 45). If you have
selected the Speed or Fast options, you may not get the most accurate colors. If you change the
print-quality settings, you may wish to reprint your job at this point in case the problem has been
solved.

4. If you are using Application Color Management, check that the color profile you are using
corresponds to the selected paper type and print-quality settings. If you have doubts about which
color settings to use, see Color management on page 53.

5. If the problem consists of color differences between your print and your monitor, please follow the
instructions in the “How to calibrate your monitor” section of the HP Color Center. At this point, you
may wish to reprint your job in case the problem has been solved.

6. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 133.

7. Try using the color adjustment options to produce the colors you want. See Color adjustment
options on page 56.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

Color accuracy using EPS or PDF images in page layout applications

Page layout applications such as Adobe InDesign and QuarkXPress do not support color management
of EPS, PDF or grayscale files.
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If you have to use such files, try to ensure that the EPS, PDF or grayscale images are already in the
same color space that you intend to use later on in Adobe InDesign or QuarkXPress. For instance, if
your final goal is to print the job in a press that follows the SWOP standard, convert the image into SWOP
when you create it.

Colors are fading

If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for
more than two weeks, you should laminate them to achieve longer life.

Prints on swellable coated papers will fade much less rapidly. However, lamination will increase the life
of prints (depending on the type of lamination) with all paper types. For more information, consult your
laminate provider.

The image is incomplete (clipped at the bottom)

e Did you press Cancel before all the data were received by the printer? If so, you have ended the
data transmission and will have to print the page again.

e The l/O timeout setting may be too short. This setting determines how long the printer waits for
the computer to send more data, before deciding that the job is finished. From the front panel,
increase the 1/O timeout setting to a longer period and then send the print again. From the

Connectivity menu , select Advanced > Select I/0 timeout.

e  There may be a communications problem between your computer and the printer. Check your USB
or network cable.

e Check to make sure that your software settings are correct for your current page size (for example,
long-axis prints).

)
=
3
g
o
c
=
-
<
=
]
c
o
7]

e If you are using network software, make sure it has not timed out.

The image is clipped

Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and
the printable area as understood by your software.

e  Check the actual printable area for the paper size you have loaded.
printable area = paper size — margins

e Check what your software understands to be the printable area (which it may call "printing area"
or "imageable area"). For example, some software applications assume standard printable areas
that are larger than those used in this printer.

e If you have defined a custom page size with very narrow margins, the printer may impose its own
minimal margins, clipping your image slightly. You may want to consider using a larger paper size,
(see Select margins options on page 47).

e If your image contains its own margins, you may be able to print it successfully by using the Clip
Contents by Margins option (see Select margins options on page 47).

e Ifyou are trying to print a very long image on a roll, check that your software is capable of printing
an image of that size.
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e You may have asked to rotate the page from portrait to landscape on a paper size that is not wide
enough.

e If necessary, reduce the size of the image or document in your software application, so it fits
between the margins.

There is another possible explanation for a clipped image. Some applications, such as Adobe
Photoshop, Adobe lllustrator and CorelDRAW, use an internal 16-bit coordinate system which means
that they cannot handle an image of more than 32,768 pixels. If you try to print an image larger than this
from these applications, the bottom of the image will be clipped. In this case, the only way to print the
whole image is to reduce the resolution so that the whole image requires fewer than 32,768 pixels. The
PCL and HP-GL/2 drivers for Windows include an option called 16-bit App. Compatibility, which can
be used to reduce the resolution of such images automatically. You can find this option in the
Advanced tab, under Document Options > Printer Features.

Some objects are missing from the printed image

Large quantities of data may be necessary to print a high-quality large-format print job, and in some
specific workflows there may be issues that can lead to some objects missing from the output. Here are
some recommendations for the use of the PCL or HP-GL/2 drivers for Windows in these cases.

e Inthe Advanced tab, select Document options, Printer features and set Send job as bitmap
to Enabled (HP-GL/2 driver only).

e Inthe Advanced tab, select Document options, Printer features and set 16-bit App.
Compatibility to Enabled.

e Inthe Advanced tab, select Document options, Printer features and set Max. Application
resolution to 300.

The above settings are mentioned for troubleshooting purposes and may adversely affect the final output
quality or the time necessary to generate the print job. Therefore, they should be restored to their default
values if they do not help to solve the problem.

"
o
S
"
=0
>
=
©
)
o
-
c
=
o

If you are working under Mac OS, the above settings are not available. Instead, you could try reducing
the resolution of bitmap images in your application software.

A PDF file is clipped or objects are missing

In older versions of Adobe Acrobat or Adobe Reader, large PDF files could be clipped or lose some
objects when printing with the HP-GL/2 driver at high resolution. In order to avoid such problems,
upgrade your Adobe Acrobat or Adobe Reader software to the latest version. From version 7 onwards,
these problems should be solved.

The Image Diagnostics Print

The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It
helps you to check the performance of the printheads that are currently installed in your printer, and
whether any printhead suffers from clogging or other problems.
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To print the Image Diagnostics Print:

1. Use the same paper type that you were using when you detected a problem.

2. Use the View loaded paper key m on the front panel to check that the selected paper type is the

same as the paper type loaded into the printer.

3. Atthe printer's front panel, select the Image Quality Maintenance menu icon , then Print
diagnostic image.

It takes about two minutes to print the Image Diagnostics Print.

The print is divided into two parts, both of which test printhead performance.

e Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the
print quality that you will get from each color.

e Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part
complements the first, and aims more specifically to detect how many faulty nozzles each printhead
has.

Please look carefully at the print. The names of the colors are shown above the rectangles and in the
center of the patterns of dashes.
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First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without
any horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most
of the dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead
responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing
dashes in part 2; these are acceptable because the printer can compensate for a few clogged nozzles.

Here is an example of a gray printhead in a good state:
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And here is an example of the same printhead in a bad state:
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Corrective action

1.

ENWW

Clean any faulty printheads (see Clean the printheads on page 139). Then reprint the Image
Diagnostics Print to see whether the problem has been solved.

If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see
whether the problem has been solved.

If the problem remains, consider cleaning your printheads manually (see Clean the printheads
on page 139). You could also try reprinting your current print job, in case it now prints satisfactorily.

If the problem remains, try cleaning the printhead drop detector. The printer normally notifies you
when this is necessary, but it may be worth trying even if the printer has not suggested it. See
Clean the printhead drop detector on page 139.

If the problem still remains, replace any persistently faulty printheads (see Handling ink cartridges
and printheads on page 83), or contact HP Support (see Contact HP Support on page 156).
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If you still have a problem

If you still experience print-quality problems after applying the advice in this chapter, here are some
further things that you can do:

Try using a higher print-quality option. See Printing on page 45.

Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about
the problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can
be downloaded from htip://www.hp.com/go/T620/drivers/.

If you are using a non-HP RIP, its settings may be incorrect. See the documentation that came with
the RIP.

Check that your printer's firmware is up to date. See Update the firmware on page 101.

Check that you have the right settings in your software application.
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14 Troubleshooting ink cartridge and
printhead issues

° Cannot insert an ink cartridge

° Ink cartridge status messages

° Cannot insert a printhead

e The front-panel display recommends reseating or replacing a printhead

° Clean the printheads

° Clean the printhead drop detector

e Align the printheads

° Printhead status messages
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Cannot insert an ink cartridge
1. Check that you have the correct type of cartridge (model number).
2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label
right-side up and readable.

/A CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages

These are the possible ink cartridge status messages:

e OK: the cartridge is working normally, with no known problems.

e Missing: there is no cartridge present, or it is not correctly connected to the printer.
e Low: theink level is low.

e Very low: the ink level is very low.

e Empty: the cartridge is empty.

e Reseat: you are recommended to remove the cartridge and then reinsert it.

e Replace: you are recommended to replace the cartridge with a new cartridge.

e Altered: there is something unexpected about the cartridge's status.

e Expired: it is past the cartridge's expiration date.

Cannot insert a printhead
1. Check that you have the correct type of printhead (model number).
Check that you have removed the two orange protective caps from the printhead.

Check that the colored label on the printhead is the same color as the label on the slot.

@ N

Check that the printhead is correctly oriented (compare with the others).
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5.  Check that you have correctly closed and latched the printhead cover, see Insert a printhead
on page 91.
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The front-panel display recommends reseating or
replacing a printhead

1. From the front panel, turn the power off then on.

2. Check the front-panel display message, if it shows the ready message, the printer is ready to print.
If the problem remains continue with the next step.

3.  Remove the printhead, see Remove a printhead on page 88.

4. Clean the electrical connections on the backside of the printhead with a lint free cloth. You can
carefully use a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.

/\ CAUTION: This is a delicate process and may damage the printhead. Do not touch the nozzles
on the bottom side of the printhead, especially not with any alcohol.

5. Reinsert the printhead, see Insert a printhead on page 91.

6. Check the front-panel display message. If the problem remains, try a new printhead.

Clean the printheads

As long as the printer is kept turned on, an automatic cleaning is performed periodically. This ensures
there is fresh ink in the nozzles and prevents nozzle clogs, which ensures color accuracy. If you have
not already done so, please see The Image Diagnostics Print on page 133 before proceeding.

To clean the printheads, press the Menu key to return to the main menu and select the Image Quality
Maintenance menu icon , then Clean printheads. If you have gone through the Image Quality

Diagnostic print process, you know which colors are failing. Select the pair of printheads which contain
the failing colors. If you are not sure which colors to clean, you can also select to clean all printheads.
Cleaning all printheads takes about nine minutes. Cleaning a single pair of printheads takes about six
minutes.
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Bf NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

Clean the printhead drop detector

The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in
order to substitute them for good printing nozzles. If particles, such as fibers, hair or paper pieces, block
the sensor print-quality is affected.
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When the front panel displays a warning message that the clean process is needed, you are
recommended to clean the printhead drop detector. If you do not clean the printhead drop detector
immediately, the printer continues working normally, however, the front panel display continues to show
the warning.

/A CAUTION: Wear gloves to avoid getting ink on your hands.

W

1. Turn off the printer at the front panel.

2. To avoid an electric shock, switch the printer off and unplug it.

3. Open the window.
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4. Find the printhead drop detector beside the stored printhead carriage.

5.  Remove any debris blocking the printhead drop detector.

6.  With a dry lint free cloth, wipe the surface of the drop detector to remove any non-visible debris.

e L

7. Close the window.
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8. Plug in and switch on the printer.

9. Power the printer on at the front panel.
(\CJ)\

Align the printheads

Precise alignment between printheads is essential for accurate colors, smooth color transitions and
sharp edges in graphical elements. Your printer has an automatic printhead alignment process which
runs whenever a printhead has been accessed or replaced.

In cases where the paper has jammed or you are experiencing problems with color accuracy, see Color
management on page 53; you may need to align the printheads.

Ef NOTE: If the paper has jammed, it is recommended that you reinsert the printheads and initiate the
realignment procedure with the Image Quality Maintenance menu .

/A CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

Reinsert printheads procedure

1. If the realignment process is running and the wrong paper is loaded, press the Cancel key on the
front panel.
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/A CAUTION: Do not print if the realignment process has been canceled. You can restart the
alignment with the Image Quality Maintenance menu procedure.

2. Load the paper you wish to use, see Paper handling on page 23. You can use a roll or cut sheet,
however, it must be A3 landscape or larger.

/A CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

3.  Remove and re-insert all the printheads, see Remove a printhead on page 88 and Insert a
printhead on page 91. This starts the printhead alignment procedure.
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4. Ensure the window is closed, as a strong light source near the printer during printhead realignment
can affect alignment.

5. The process takes about six minutes. Wait until the front-panel display shows the process complete
before using the printer.

Bf NOTE: The printer prints a calibration image. Do not worry about the image. The front-panel
display shows any errors in the process.

Image Quality Maintenance menu procedure

Scanning errors during alignment

ENWW

1. Load the paper you wish to use, see Paper handling on page 23. You can use a roll or cut sheet,
however, it must be A3 landscape or larger (420 by 297 mm).

/A CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

2. Press the Menu key to return to the main menu and select the Image Quality Maintenance menu
icon , then Align printheads. The printer checks to see if it has enough paper to run the
realignment.

3. Ifthe loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.

Ensure the window is closed, as a strong light source near the printer during printhead realignment
can affect alignment.

4. The process takes about five minutes. Wait until the front-panel display shows the process
complete before using the printer.
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If the alignment process fails, a Scanning problems message appears on the front panel. This means
that the alignment has not completed successfully. Therefore the printer is not aligned and the alignment
should be repeated before printing with good image quality. The problem may be due to:

e The paper used was not valid, repeat the alignment with valid paper

e Printhead health problems, clean printheads, see Clean the printheads on page 139

e The alignment was done with the window open, repeat the alignment with the window closed

If the problem persists after using valid paper, cleaning the printheads and keeping the window closed,
there may be a failure in the scanning system needing reparation or the printheads, although clean, may
not work and need to be replaced.
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Printhead status messages

These are the possible printhead status messages:

OK: the printhead is working normally, with no known problems
Missing: there is no printhead present, or it is not correctly installed in the printer.

Test printhead separately: you are recommended to test the printheads individually to find the
failing printhead. Remove all the printheads and insert them alone one by one, closing the latch
and the carriage cover after every insertion. The front-panel display indicates the failing one
showing the reseat or replace message.

Reseat: you are recommended to remove the printhead and then reinsert it. If that fails, clean the
electrical connections, see The front-panel display recommends reseating or replacing a
printhead on page 139. If that fails, replace the printhead with a new printhead, see Remove a
printhead on page 88 and Insert a printhead on page 91.

Replace: the printhead is failing. Replace the printhead with a working printhead, see Remove a
printhead on page 88 and Insert a printhead on page 91.

Replacement incomplete: a printhead replacement process has not completed successfully, re-
launch the replacement process and let it finish completely (it is not needed to change the
printheads).

Remove: the printhead is not a suitable type for use in printing.
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Troubleshooting general printer issues

° The printer does not print

e The printer seems slow

° Communication failures between computer and printer

° Cannot access the HP Printer Utility

° Cannot access the Embedded Web Server

e Automatic file system check

e An AutoCAD 2000 memory allocation error

° No output when printing from Microsoft Visio 2003

e Unavailable driver features when printing from QuarkXpress

° Printer alerts

145

N
[(«2)
=
(/2]
2
15
(]
]
c
=
Q.
©
t o
(%)
c
<))
o




®
(1)
>
(1)
=
-,
©
=
>
-~
(1)
=
(7]
(7]
c
(1]
(7]

The printer does not print

If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons
why a file you have sent from your computer may not start printing when expected:

You may have an electrical power problem. If there is no activity at all from the printer, and the front
panel does not respond, check that the power cable is connected correctly and that there is power
available at the socket.

You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic
fields or severe electrical disturbances, which can cause the printer to behave strangely or even
stop working. In this case, turn off the printer using the Power key on the front panel and unplug
the power cord, wait until the electromagnetic environment has returned to normal, then turn it on
again. If you still experience problems, please contact your customer service representative.

You may have the wrong graphic language setting, see Change the graphic language setting
on page 21.

You may not have installed in your computer the correct driver for your printer, see the Assembly
instructions.

If you are printing on a sheet, you must specify Manual Feed as the paper source in your printer
driver.

The printer may be holding the job for paper.

The printer seems slow

Here are some possible explanations.

Did you set the print-quality to Best or Max Detail? Best-quality and maximum detail prints take
longer.

Did you specify the correct paper type when loading the paper? Some paper types require more
time for printing, for example, photo and coated papers require more drying time between passes.
To find out the printer's current paper type setting, see View information about the paper

on page 40.

Do you have a network connection to your printer? Check that all components used in the network
(network interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is
there a lot of traffic from other devices on the network?

Did you specify Extended drying time in the front panel? Try changing the drying time to
Optimal.

Communication failures between computer and printer

Some symptoms are:

The front-panel display does not show the Receiving message when you have sent an image to
the printer.

Your computer displays an error message when you are trying to print.
Your computer or printer hangs (stays idle), while communication is taking place.

Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)
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To solve a communication problem:

e Ensure that you have selected the correct printer in your application, see Printing on page 45.

e  Ensure that the printer works correctly when printing from other applications.
e Remember that very large prints may take some time to receive, process and print.

e If the printer is connected to a network, try using it when connected directly to your computer
through a USB cable.

e Ifyourprinteris connected to your computer through any other intermediate devices, such as switch
boxes, buffer boxes, cable adapters, cable converters, etc., try using it when connected directly to
your computer.

e  Try another interface cable.

e Ensure that the graphic language setting is correct, see Change the graphic language setting
on page 21.

e Ifthe printer is connected with a USB, try to disconnect and reconnect the USB cable with the
computer.

Cannot access the HP Printer Utility

If you have not done so already, please read Access the HP Printer Utility on page 19.

1. To use the HP Printer Utility (Mac OS), you must have a USB connection to your printer.

2. Press the Menu key to return to the main menu and select the Connectivity menu icon .

3. Select Advanced > Web Services > Printer Utility Software > Enable.

4. If you have a TCP/IP connection to your printer, press the Menu key to return to the main menu
and select the Connectivity menu icon again.

5. Select the type of connection you are using.

6. Select View Information.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Cannot access the Embedded Web Server

If you have not done so already, please read Access the Embedded Web Server on page 19.

B NOTE: If you connect to your printer by USB, TCP/IP or Jetdirect, use the HP Printer Utility.

1. Press the Menu key to return to the main menu and select the Connectivity menu icon .

2. Select Advanced > Embedded Web Server > Allow EWS > On.

3. If you have a TCP/IP connection to your printer, press the Menu key to return to the main menu
and select the Connectivity menu icon again.

4. Select the type of connection you are using.
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5. Select View Information.
6. Ensure that you see IP enabled. If not, you may need to use a different connection.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Automatic file system check

When you turn on the printer, you will occasionally see a front panel display similar to the one shown

D

invent
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A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.

/\ CAUTION: If you turn the printer off before the file system check has finished, the file system could
be seriously damaged. In any case, the file system check will
restart from the beginning whenever you turn the printer on again.

Ef NOTE: When the printer is powered back on, it takes about three minutes to initialize and check and
prepare the printheads. However, it can take up to 40 under some conditions, for example, when the
printer has not been used for a long period of time and requires more time to prepare the printheads.

An AutoCAD 2000 memory allocation error

After installing the printer driver, when you try to print for the first time from AutoCAD 2000, you may
see a message saying Memory allocation error, after which your image is not printed.

This is due to a problem in AutoCAD 2000, and it can be fixed by downloading the Plotting Update Patch
(plotupdate.exe) from the Autodesk Web site, hitp://www.autodesk.com/.

This patch is also worth trying if you have any other strange problems when printing from AutoCAD
2000.

No output when printing from Microsoft Visio 2003

For more information about problems when printing large images (more than 129 inches long) from
Microsoft Visio 2003, see Microsoft's online knowledge base: htip://support.microsoft.com/search/.

To avoid these problems, it is possible to scale the image down in Visio to a size shorter than 129 inches
and then to scale the drawing up in the driver by using the Resizing Options in the Features tab of the
Windows driver. If the down-scaling in the application and the up-scaling in the driver match, the result
is as originally intended.
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Unavailable driver features when printing from
QuarkXpress

When you print from QuarkXPress, the following driver features are not available.
e Rotation

e Resizing

e  Paper saving options

To get the same results, use the equivalent features available in QuarkXPress.

Printer alerts

Your printer can communicate two types of alerts:

e Errors: Mainly alerting you to the fact that the printer is unable to print. However, in the driver,
errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer
is able to print.

e Warnings: Alert you when the printer needs attention either for an adjustment, such as calibration
or for a possible unprintable situation, such as preventive maintenance or low ink.

There are four different alerts communicators within your printer's system.

o Front-panel display: The front panel only shows the most relevant alert at a time. It generally
requires the user to press the OK key for confirmation, but in the case of a warning, it disappears
after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear when
the printer becomes idle and there is not another more severe alert.

e Driver: The driver shows alerts. The driver warns about job configuration settings that may produce
a problem in the final output. If the printer is not ready to print, it displays a warning.

e HP Printer Utility: To see alerts in these applications, go to the Overview tab and review the
Items needing attention list on the right-hand side.

By default, alerts are only displayed when you are printing and there are printing problems, for
example: cartridge low or out of ink or printer out of paper. If alerts are enabled and there is a
problem that prevents printing, you see a pop-up window, which explains why the printer is not
going to print. Follow the instructions to achieve your required result.

= NOTE: There are environments that do not support bidirectional communication, for example: a
Windows computer connected to the printer with USB. In those cases, alerts do not reach the job
owner.
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16 Front-panel error messages

2
o
|
o
o
o
c
®
o
-
c
o
S
w

Occasionally you may see one of the following messages appear on the front-panel display. If so, please
follow the advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response,
contact HP Support. See Contact HP Support on page 156.

Table 16-1 Text messages

Message Recommendation

[Color] cartridge has expired Replace the cartridge. See Handling ink cartridges and
printheads on page 83.

[Color] cartridge is missing Insert a cartridge of the correct color. See Handling ink
cartridges and printheads on page 83.

[Color] cartridge is out of ink Replace the cartridge. See Handling ink carfridges and
printheads on page 83.

[Color] printhead #[n] error: not present Insert the correct printhead. See Handling ink cartridges and
printheads on page 83.

[Color] printhead #[n] error: please remove Remove the incorrect printhead and insert a new printhead of
the correct type (color and number). See Handling ink
cartridges and printheads on page 83.

[Color] printhead #[n] error: replace Remove the non-functional printhead and insert a new
printhead. See Handling ink cartridges and printheads
on page 83.

[Color] printhead #[n] error: reseat Remove and reinsert the same printhead, or try cleaning the

electrical connections. If necessary, insert a new printhead.
See The front-panel display recommends reseating or
replacing a printhead on page 139.

[Color] printhead #[n] out of warranty The printhead's warranty has expired, because of the length of
time it has been in operation or because of the volume of ink
used.

[Color] printhead #[n] warranty warning The printhead's warranty may be invalidated by the use of the

wrong kind of ink.

10 error Restart the printer. If the problem persists, contact HP Support.
See Contact HP Support on page 156.

10 warning Try again; if the problem persists, contact HP Support. See
Contact HP Support on page 156.

Paper advance calibration pending Perform paper advance calibration. See Recalibrate the paper
advance on page 119.

Paper too small to print paper advance calibration Unload paper and load larger paper.
Paper too small to scan paper advance calibration Unload paper and load larger paper.
PDL Error: Ink system not ready Clean the printheads. See Clean the printheads on page 139.
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Table 16-1 Text messages (continued)

Message

Recommendation

PDL Error: Job clipped

The image is too large for the paper or for the printer. Load
larger paper if possible, or reduce the image size.

PDL Error: memory full

Restart the printer and try resending the job; if necessary,
reduce the complexity of the job.

PDL Error: out of paper

Load more paper.

PDL Error: parsing error

The print job is unintelligible to the printer. Try to recreate and
resend it. Check your cable connections.

PDL Error: print mode error

The paper type or print quality specified for the job are
incorrect. Change the loaded paper type or the print settings.

PDL Error: printing error

Try sending the job again.

PDL Error: virtual memory full

Restart the printer and try resending the job; if necessary,
reduce the complexity of the job.

Printhead alignment error: paper too small

Unload paper and load larger paper.

Replace [color] cartridge

Replace the cartridge. See Handling ink cartridges and
printheads on page 83.

Reseat [color] cartridge

Remove and reinsert the same cartridge. See Handling ink
cartridges and printheads on page 83.

Update: failed. Invalid file

Make sure that you have selected the correct firmware update
file. Then try again to perform the update.

Table 16-2 Numerical error codes

Error code Recommendation
01.0,01.1,01.2 Restart the printer. If the problem persists, contact HP Support. See Contact HP Support
on page 156.
21,21.1,22.0,22.1,22.2, Restart the printer. If the problem persists, contact HP Support. See Contact HP Support
22.3,24 on page 156.
52:01 The printer needs internal cleaning. See Clean the printhead drop detector on page 139. If the

problem persists, contact HP Support. See Contact HP Support on page 156.

61:01 The file format is wrong and the printer cannot process the job. Check the graphic language
setting of your printer (see Change the graphic language setting on page 21). Check for the
latest firmware and driver releases.

62, 63, 64, 65, 67 Update your printer's firmware. See Update the firmware on page 101.

71.04 Out of memory. To avoid this, in the HP-GL/2 driver select the Advanced tab and then Send
job as a bitmap.

741 Try the firmware update again. Do not try to use your computer while the update is in progress.
If the problem persists, contact HP Support. See Contact HP Support on page 156.

79 Restart the printer. If the problem persists, contact HP Support. See Contact HP Support
on page 156.
94,941 Restart color calibration. See Color calibration on page 54.
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e HP Proactive Support

e Contact HP Support

153

o
L
®

(&)
o
o
£
O

whud
7]
S

&

o

I




Introduction

HP Customer Care offers award-winning support to ensure you get the most from your HP Designjet,
providing comprehensive, proven support expertise and new technologies to give you unique end-to-
end support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair
and exchange services, phone and Web support, software updates and self-maintenance services. To
find out more about HP Customer Care, please visit us at:

http://www.hp.com/go/graphic-arts/

or call us on the telephone (see Contact HP Support on page 156). To register your warranty:

http://reqister.hp.com/

HP Professional Services

Knowledge Center

Enjoy a world of dedicated services and resources to ensure you always get the best performance from
your HP Designjet products and solutions.
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Join the HP community at the Knowledge Center, your large-format printing community at
http://www.hp.com/go/T620/knowledgecenter/ for 24x7 access to:

e  Multimedia tutorials

e  Step-by-step how-to guides

e Downloads — the latest printer firmware, drivers, software, paper profiles, etc.
e  Technical support — online troubleshooting, customer care contacts and more

o  Workflows and detailed advice for completing various printing tasks from particular software
applications

e  Forums for direct contact with the experts, both HP and your colleagues

e  Warranty tracking online, for your peace of mind

e Latest product information — printers, supplies, accessories, software, etc.
e  Supplies Center for all you need to know about ink and paper

By customizing your registration for the products you have purchased and your type of business, and
by setting your communication preferences, you decide the information you need.

HP Start-Up Kit

The HP Start-Up Kit is the DVD that comes with your printer; it contains the printer's software and
documentation, including introductory multimedia tutorials to help you to get a good first print.

HP Care Packs and Warranty Extensions

HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the
standard period.
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They include remote support. On-site service is also provided if necessary, with two alternative
response-time options.

e Nextbusiness day
e Same business day, within four hours (may not be available in all countries)

For more information on HP Care Packs, please visit http://www.hp.com/go/lookuptool/.

HP Installation
The HP Installation service unpacks, sets up and connects the printer for you.

This is one of the HP Care Pack services; for more information, please visit http://www.hp.com/go/
lookuptool/.

HP Instant Support

HP Instant Support Professional Edition is HP's suite of troubleshooting tools that collect diagnostic
information from your printer and match it with intelligent solutions from HP's knowledge bases, allowing
you to resolve problems as quickly as possible.
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You can start an HP Instant Support session by clicking on the link provided on the Troubleshooting
page of your printer's Embedded Web Server. See Access the Embedded Web Server on page 19.

To be able to use HP Instant Support:

e You must have a TCP/IP connection to your printer, because HP Instant Support is accessible only
through the Embedded Web Server.

e You must have access to the World Wide Web, because HP Instant Support is a Web-based
service.

HP Instant Support is currently available in English, Korean, Simplified Chinese and Traditional Chinese.

You can find more information about HP Instant Support at http://www.hp.com/go/ispe/.

HP Proactive Support

HP Proactive Support helps reduce costly printer downtime by preemptively identifying, diagnosing and
resolving printer issues before they become problems for you. HP's Proactive Support tool is designed
to help businesses of all sizes reduce support costs and maximize productivity—all with the click of a
mouse.

A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control
of your printing environment—uwith a clear focus on maximizing the value of your investment, increasing
printer uptime and reducing printer management costs.

HP recommends that you enable Proactive Support right away to save you time and prevent problems
before they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for
software and firmware updates.

You can enable Proactive Support in the HP Printer Utility for Windows or the HP Printer Monitor for
Mac OS, where you can specify the frequency of connections between your computer and HP's Web
server, and the frequency of diagnostic checks. You can also choose to run the diagnostic checks at
any time. To change these settings:

e Inthe HP Printer Utility for Windows, select the Tools menu, then HP Proactive Support.

° In the HP Printer Monitor for Mac OS, select Preferences > Monitoring > HP Proactive
Support.
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If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the
problem and recommend a solution. In some cases, the solution may be applied automatically; in other
cases, you may be asked to perform some procedure to solve the problem.

Contact HP Support

HP Support is available to you by telephone. What to do before you call:

Review the troubleshooting suggestions in this guide.

Review the relevant driver documentation.

If you have installed third-party software drivers and RIPs, see their documentation.

If you call one of the Hewlett-Packard offices, please have the following information available to
help us answer your questions more quickly:

o

The printer you are using (the product number and the serial number, found on the label at
the back of the printer)

If there is an error code on the front panel, note it down; see Front-panel error messages
on page 151

The printer's Service ID: at the front panel, select the Information menu icon , then View

printer information
The computer you are using

Any special equipment or software you are using (for example, spoolers, networks, switch-
boxes, modems or special software drivers)

The cable you are using (by part number) and where you purchased it
The type of interface used on your printer (USB or network)
The software name and version you are currently using

If possible, print out the following reports; you may be asked to fax them to the support center
helping you: Configuration, and “all pages above” from Service Information (see The printer's
internal prints on page 8)

Telephone number

Your HP Support telephone number is available on the Web: please visit http://welcome.hp.com/country/
us/en/wwcontact_us.html.
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° Functional specifications

° Physical specifications

° Memory specifications

° Power specifications

° Ecological specifications
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e Acoustic specifications
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Functional specifications

Table 18-1 HP 72 ink supplies

Printheads

Two inks in each printhead: gray and photo black, matte black and yellow, and

magenta and cyan

Ink cartridges

Cartridges containing 69 ml of ink: gray, photo black, yellow, magenta and cyan

Cartridges containing 130 ml of ink: gray, photo black, matte black, yellow, magenta

and cyan
Table 18-2 Paper sizes
Minimum Maximum
Roll width 11 inches (279 mm) 24-inch printer: 24 inches (609 mm)
Roll length 300 feet (91.4 m)
Sheet width 8.3 inches (210 mm) 24-inch printer: 24 inches (609 mm)

Sheet length

11 inches (279 mm)

24-inch printer: 36 inches (915 mm)

Table 18-3 Printing resolutions

Print quality Maximum Rendering resolution (ppi) Printing resolution (dpi)
detail

Best On 1200 x 1200 2400 x 1200 on glossy paper*,

1200 % 1200 on other papers

Off 600 x 600 600 x 600

Normal On or Off 600 x 600 600 x 600

Fast On or Off 600 x 600 600 x 600

Economode Off 300 x 300 300 x 300

* For a list of supported glossy papers, see Order paper on page 106.

Table 18-4 Margins

Top right and left margins

5 mm = 0.2 inches

Bottom margin (trailing edge)

5 mm = 0.2 inches (roll)

17 mm = 0.67 inches (sheet)

Table 18-5 Mechanical accuracy

+0.1% of the specified vector length or £0.2mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/AO printing
material in Best or Normal mode with HP Matte Film roll feed.
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Table 18-6 Graphic languages supported

HP-PCL3 GUI, HP-GL/2 RTL

Physical specifications

Table 18-7 Printer physical specifications

24-inch printer 24-inch printer (without stand)
Weight 143 Ib (65 kg) 103.6 Ib (47 kg)
Width 49.7 inches (1262 mm) 49.7 inches (1262 mm)
Depth Minimum: 26 inches (661 mm) Minimum: 26 inches (661 mm)

Maximum: 28.8 inches (732 mm) Maximum: 28.8 inches (732 mm)

Height 41.2 inches (1047 mm) 15.4 inches (391 mm)

Memory specifications

Table 18-8 Memory specifications

Dedicated file-processing memory * 2GB
(72}
c
9
* 384 MB physical DRAM ©
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Power specifications S
Q
Table 18-9 Printer power specifications (7))
Source 100-240 V ac +10%, auto-ranging
Frequency 50-60 Hz
Current <2A
Consumption <200 W

Ecological specifications

This product complies with European Union WEEE and RoHS Directives. To determine the ENERGY
STAR qualification status of these product models, please go to http://www.hp.com/go/energystar/.

For the up-to-date ecological specifications of your printer, please go to http://www.hp.com/ and search
for “ecological specifications”.

Environmental specifications

Table 18-10 Printer environmental specifications

Temperature range Humidity range
Operating for optimal print-quality 22°C 10 26°C (72°F to 79°F) 30% to 60%
Operating for standard printing 15°C to 35°C (59°F to 95°F) 20% to 80%
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Table 18-10 Printer environmental specifications (continued)

Temperature range Humidity range

Printer without consumables 5°C to 40°C (41°F to 104°F)

Non-operating packed consumables and -40°C to 60°C (-40°F to 140°F)
printer:

Acoustic specifications

Printer acoustic specifications (declared according to ISO 9296).

Table 18-11 Printer acoustic specifications

Idle sound power level 4.4 B (A)
Operating sound power level 6.9B (A)
Idle sound pressure at bystander position 29dB (A)
Operating sound pressure at bystander position 57 dB (A)
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Glossary

AppleTalk A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now
recommends TCP/IP networking instead.

Bonjour Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a
computer network technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services
available on a local area network. It was originally known as Rendezvous.

Color accuracy The ability to print colors that match the original image as closely as possible, bearing in mind
that all devices have a limited color gamut and may not be physically capable of matching certain colors precisely.

Color consistency The ability to print the same colors from a particular print job from print to print and from
printer to printer.

Color model A system of representing colors by numbers, such as RGB or CMYK.

Color space A color model in which each color is represented by a specific set of numbers. Many different color
spaces can use the same color model: for instance, monitors generally use the RGB color model, but they have
different color spaces, because a particular set of RGB numbers results in different colors on different monitors.

Cutter A printer component that slides back and forth across the platen to cut the paper.

ESD ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door,
or the cling of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic
discharges are one of the main hazards to the electronics products. Therefore, to prevent damage some
precautions are needed when setting up the product, or handling ESD sensitive devices. This type of damage may
reduce the life expectancy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type
of damage is by touching any exposed grounded part of the product (mainly metal parts) before handling ESD
sensitive devices (such as the printheads or ink cartridges). Additionally, to reduce the generation of electrostatic
charge in your body try to avoid working in a carpeted area, and keep your body movements to a minimum when
handling ESD sensitive devices. Also, avoid working in low humidity environments.

Ethernet A popular computer networking technology for local area networks.

Firmware Software that controls your printer's functionality and is stored semi-permanently in the printer (it can
be updated).

Gamut The range of colors and density values reproducible on an output device, such as a printer or monitor.
HP-GL/2 Hewlett-Packard Graphics Language 2: a language defined by HP to describe vector graphics.
/0 Input/Output: this term describes the passing of data between one device and another.

ICC The International Color Consortium, a group of companies that have agreed on a common standard for color
profiles.

Ink cartridge A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address A unique identifier that identifies a particular node on a TCP/IP network. It consists of four integers
separated by dots.
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Jetdirect HP's brand name for its series of print servers that allow a printer to be connected directly to a local
area network.

LED Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address Media Access Control address: a unique identifier used to identify a particular device on a network.
It is a lower-level identifier than the IP address. Thus, a device may have both a MAC address and an IP address.

Nozzle One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which
are pulped, dried and pressed.

Platen The flat surface within the printer over which the paper passes while it is being printed on.
Printer driver Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead A removable printer component that takes ink of one or more colors from the corresponding ink
cartridge(s) and deposits it on the paper, through a cluster of nozzles. In the HP Designjet T620 series, each
printhead prints two different colors.

Rendezvous Apple Computer's original name for its networking software later known as Bonjour.
Spindle A rod that supports a roll of paper while it is being used for printing.

TCP/IP Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is
based.

USB Universal Serial Bus: a standard serial bus designed to connect devices to computers.
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reprint last job 51
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paper not in driver 114
roll cannot load 112
roll cannot load 24-inch 112
roll into 24-inch printer 28
roll into 24-inch printer easy
load 29
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paper menu 31
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sheet cannot load 113

sheet easy load 38

sheet paper menu load 39
loading paper problems 112

M
maintenance kits 102
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none 51

specification 158
mechanical accuracy 158
memory error (AutoCAD) 148
memory specifications 159
Microsoft Office

print from 76
misaligned colors 125
move the printer 100

N
Network settings 21
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ink cartridges 106

paper 106

printheads 106
overlapping lines 49

P
page size 46
paper
advance 42
calibrate the paper
advance 119
cannot load 112
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feed and cut 42
jammed 115
loading error messages 113
maintenance 42
not flat 128
output problems in basket 118
paper not in driver 114
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size 46
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view information 40
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paper types 106
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PDF missing objects 133
physical specifications 159
platen cleaning 129
power
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preferences, Windows driver 16
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print quality
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print-quality problems
banding 123
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blurred lines 126
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ink marks 129
line thickness 124
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paper not flat 128
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scuffing 128
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colors 130
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wizard 122
printer does not print 146
printer software
Mac OS uninstall 13
Windows uninstall 12
printer stand 110
printer status 96
Printer Utility
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cannot access 147
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printer's main features 4

printhead
about 87
align 142

cannot insert 138
clean; purge 139
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order 106
remove 88
replace, reseat 139
specification 158
status 88
printhead cleaner
specification 158
printhead drop detector
clean 139
printing resolutions 158
Proactive Support 155
project, print 62

Q

quality, high 50

QuarkXpress, unavailable driver
features 149

R
reprint last printed job 51
rescale a print 48
roll paper
24-inch load 28
24-inch spindle load 24

ENWW

S
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scratched prints 128
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sheet paper
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slow printing 146
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software update 102
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graphic languages 159
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